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S Corporations (1120S)

The basics of data entry for an S corporation (1120S) return are the same as for a 1040 
return. Field- and screen-level help, shortcut keys, and navigation throughout data 
entry all function as they do in the 1040. See the Drake Software User’s Manual: Tax 
Year 2010 for the basics of using the program.

What’s New in Drake for S Corporations
Drake programs its tax software according to the latest IRS rules and regulations. The 
2010 program reflects all changes to credits and deductions, including discontinua-
tions. For details on the new regulations for the 2010 tax year, see the IRS instructions 
for Form 1120S.

Data Entry and Calculation
This year’s changes to data entry and calculation are summarized below:

• Improved Calculation Results Window — The Calculation Results window 
now features more EF message links. (An EF message link takes you directly to 
the screen that is causing the EF message.)

• Multiple Forms 8027 Available — Returns can now include multiple instances 
of Form 8027, Employer’s Annual Information Return of Tip Income & Allocated 
Tips.

• Depreciation on Installment Sales and Like-Kind Exchanges — For a sold 
item on the 4562 (Depreciation Detail) screen, three new options are available in 
the Property type drop list (located in the If sold section of the screen). Selecting 
one of these options (listed below) prevents the program from automatically car-
rying the sale information to Form 4797.
– IN — Installment sale, section 1245 property (Form 6252)
– IS — Installment sale, section 1250 property (Form 6252)
– LK — Like-kind exchange (Form 8824)

• Section 179 Expensing for Qualified Real Property — In accordance with the 
Small Business Jobs Act of 2010, a taxpayer may elect, under section 179, to 
Tax Year 2010 1



What’s New in Drake for S Corporations Drake Software User’s Manual Supplement: S Corporations
expense up to $250,000 of the cost of qualifying real property placed in service 
during the taxable year. In Drake, this election is made on the 4562 screen.

Screens and Forms
This year’s changes and enhancements to screens and forms are summarized below: 

• Screen L — The L screen and L2 screens from previous years have been consoli-
dated into one screen for easier data entry. Links to the SCH2 screen are provided 
for those items requiring a subsidiary schedule.

• Schedule M-2 worksheets — Worksheet WK_M2 is now produced if a Schedule 
M-3 is present on a return.

• Form 5884-B supported — The new IRS Form 5884-B, New Hire Employment 
Credit, is included in the 2010 program. Use screen 588B to complete this form.

• Form 8941 — Form 8941, Credit for Small Employer Health Insurance Premi-
ums, has been added to all packages. Use screen 8941 to complete information for 
this credit.

• Schedule N added — Schedule N, Foreign Operations of U.S. Corporations, has 
been added to the 1120S package. Use screen N to enter data for this form.

• AMD screen — This screen is used for amended returns and includes fields for 
entering changes and explanations. For more information on amending an 1120S 
return, see “Amending a Return” on page 14.

• DIST screen — Use the DIST screen to enter date and distribution amounts for 
Schedule K, line 16d, Distributions. In addition to line 16d, the total from the 
DIST screen may flow to Schedule M-2, line 7 (subject to limitations), and to the 
Schedules K-1, based on the shareholder’s ownership percentage. Schedule K-1 
distribution information is displayed on the K1_DIST worksheet produced with 
the return.

Electronic Filing Features
This year’s e-filing changes for the S corporation package are listed below: 

• Amended Returns EF Eligible — Amended 1120S returns are now eligible for 
e-filing. See “Amending a Return” on page 14 for information on e-filing an 
amended Form 1120S.

• More EF “Trapping” For Business Returns — New programming will help the 
software catch more errors in a return before the return can be e-filed and then 
rejected by the IRS.

• EF Messages and Notes — Many of the EF messages and notes pages have been 
rewritten for improved clarity and to better help with trouble-shooting issues in 
business returns.

• EF Messages for Accepted Returns — An EF messages is now produced when a 
return or extension is calculated that has already been e-filed and accepted.
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Before You Start
Actions you might need to take before starting an 1120S return in Drake include:

• Updating a prior-year return (if you prepared the tax return last year)
• Electing as an S corporation (if the corporation was not an S corporation last year)

Updating a Prior-Year Return in Drake
A prior-year return can be updated in three ways:

• With all other returns in the program using Last Year Data > Update 2009 to 
2010 (not recommended)

• As a single return (updated one at a time) using Last Year Data > Update 2009 
to 2010 (recommended) 

• When you open the return for the first time in the 2010 program and are prompted 
to update it

When you update an 1120S return that was previously marked as “final,” the program 
informs you that the return was marked final before prompting you to proceed.

Indicating an S Corporation
If the corporation is electing as an S corporation for the first time, it is necessary to 
indicate this in the program.

S Corp 
Election

On screen 1 in the General Information section, line A, enter the date of election as 
an S corporation. On line E, enter the date incorporated.

Form 2553, Election by a Small Business Corporation, is required if the entity is mak-
ing the election with the return. In Drake, use screen 2553, accessible from the Other 
Forms tab or by clicking the Form 2553 link on screen 1.

1120 to 
1120S

To change a “C” corporation to an S corporation (1120 to 1120S):

1. Go to Tools > File Maintenance > Change File Type.
2. Enter the EIN of the entity.
3. Select the new return type (1120S).
4. Click OK to save the change.

Header Information
Screen 1 contains fields for the general information that is printed in the top section of 
page 1 of Form 1120S.

NOTE
If attaching a signed Form 2553 to the return as a PDF, mark the 
Attaching Form 2553 as a PDF document box on screen 1. If not sent 
as a PDF, the form must be mailed separately to the IRS before filing 
the tax return. See Form 2553 instructions at www.irs.gov.
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Name and Address
Use screen 1 to complete the corporation name and address section of Form 1120S. 
For state purposes only, if the corporation has an alternate address (such as a P.O. 
box), you can enter that address on screen 2, in the Address Line 2 field at the bottom 
of the screen.

Tax Year
The software uses the calendar year as the default period for all corporate returns; no 
date entries are required on screen 1 for a December 31 tax year end.

Fiscal and 
Calendar 

Years

If the S corporation uses a fiscal year (where the year begins in the current calendar 
year and ends in the next), specify the beginning and ending dates in the If not calen-
dar year section of screen 1.

Short-Year 
Returns

An entity may have a short-year return if changing accounting periods with IRS 
approval (Form 3115), or if this is its first or last year in business and the tax year is 
not a full year.

To indicate a short-year return, use the fiscal year date fields on screen 1 to indicate 
the beginning and ending dates for the current year. (These fields should not be used if 
the entity uses a calendar year.)

If filing a short-year return (other than an initial or final return), you will need to pro-
vide an explanation. To do so, go to the ELEC screen and select an explanation from 
the Reason for short year drop list. The explanation will be displayed at the top of 
the first page of the tax return. If you do not select an explanation, an EF message will 
be generated with the return, and the return cannot be e-filed.

Boxes A through I
Enter most information for boxes A through I (top of Form 1120S) on screen 1. Note 
that boxes C (“M-3 attached”) and F (“Total assets”) are completed automatically by 
the program based on data entered elsewhere. Other boxes are:

• Box A — S election effective date
• Box B — Business activity code (From screen 1, choose a code from the line B 

drop list, or click in the line B field and press CTRL+SHIFT+S to search for a code)

NOTES
The program adjusts calculations for depreciation and for gains and 
losses on sales of assets based on the entity’s tax year.
For information on filing with a 52-53–week year, see “Electing a 52-
53–Week Year (Initial Return)” on page 33.

NOTES
For more information on short-year explanations, see IRS Pub. 4163.
The program may not correctly calculate depreciation, gains, or losses 
for a short-year return. Depreciation for a short-year return can be 
entered on screen 4562 and/or screens 6, 7, 8, and 9.
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• Box D — Employer Identification Number (EIN) (program uses setup data as 
default)

• Box E — Date incorporated
• Item G — Indicates first year as S corporation and inclusion of Form 2553 with 

return
• Item H — Check boxes for final return, name change, address change, amended 

return, and S election termination or revocation)
• Item I — Number of shareholders during the year (completed automatically based 

on the number of K-1s; number can be overridden on line I of screen 1.)

Income and Deductions
Income and deductions are entered primarily on screen 3, the INC (Other Income) 
screen, and the DED (Other Deductions) screen.

Gross Receipts
Enter gross receipts (Form 1120S, line 1a) and returns and allowances (line 1b) on 
screen 3. Line 1a of screen 3 is an adjustment field; it adjusts the amount, if any, that 
flows from screen F (Schedule F, Profit or Loss from Farming).

The program calculates gross receipts or sales after returns and allowances based on 
gross receipts, sales, and any direct entry on line 1b.

Cost of Goods Sold (Schedule A)
For cost of goods sold (COGS), complete screen A (Schedule A, Cost of Goods Sold).

Inventory Inventory amounts entered on lines 1 and 7 of screen A automatically flow to Sched-
ule L, line 3 (“Inventories”). Note that the fields on the L screen (Schedule L - Bal-

NOTE Enter accounting method at the bottom of screen 1.

NOTE For information on the Schedule K items at the bottom of screen 3, see 
“Schedule K: Shareholders’ Pro Rata Share Items” on page 16.

NOTE
The IRS does not require a detail (Ctrl+W) worksheet for gross receipts; 
therefore, if you are using the trial balance import feature, do not 
include a detail worksheet for this line—or for any other line that does 
not require a detail worksheet. For more on the trial balance worksheet, 
see “Importing Trial Balance Information” on page 38.

NOTE
On screen A, items 9a through 9f are direct-entry fields and follow the 
format of IRS Schedule A. For more information on completing these 
fields, press F1 or consult the IRS instructions.
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ance Sheet - Assets) are overrides. Anything entered there overrides the inventory 
data that flows from screen A.

Line 5, Other 
Costs

Line 5 of Schedule A is designated for any applicable costs not entered on the previ-
ous lines. In Drake, two fields are provided for line 5: one for other costs excluding 
depreciation, and one for depreciation (Figure 1).

Figure 1: Other Costs and Depreciation

In the Depreciation field, enter any depreciation that relates to the cost of goods sold 
(unless the amount is flowing from the 4562 Detail screen with COGS selected from 
the For drop list). (Note that this field is an override field; an entry here overrides cal-
culations from the 4562 screen.) Amounts entered in this field automatically adjust the 
total depreciation that is carried to page 1 of Form 1120S. For Other costs - exclud-
ing depreciation, use a CTRL+W worksheet. The depreciation amount is included on 
the statement for other costs and should not be included in the Other Costs work-
sheet.

Importing 
Trial Balance 

to Sch A

If using the trial balance import feature (see “Importing Trial Balance Information” on 
page 38), enter depreciation amounts directly into the appropriate fields on the trial 
balance worksheet, not in the fields in data entry. When the trial balance is imported, 
the COGS depreciation expense amount flows directly to the appropriate line of 
Schedule A and is calculated accordingly.

Ordinary Gains and Losses
The amount on line 4 (Net gain (loss) from Form 4797, Part II, line 17) of Form 1120S 
flows from Form 4797. Amounts can also flow from screen 4562, but only if that 
screen shows assets sold and property type.

Other Income (Loss)
Enter all amounts for line 5, Other income (loss), on the INC screen. INC screen data 
is displayed on attached statements in View mode.

Amounts from the following screens also flow automatically to line 5:

• 6478 (Form 6478, Alcohol and Cellulosic Biofuel Fuels Credit)
• 8864 (Form 8864, Biodiesel and Renewable Diesel Fuels Credit)

Additional fields on the INC screen include:

NOTE
Line 14b on screen 3 (Income and Deductions) screen is for Form 
4562 depreciation that is not entered on Schedule A or elsewhere on 
the return.
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• Amount of credit for tax on fuels
• Interest income on receivables
• Recoveries of bad debts
• Section 481 adjustments
• State tax refund
• Income from insurance proceeds

To enter income or loss from a partnership, estate, or trust, use the K1P or K1F screen 
(available from the Other Forms tab). 

To enter additional sources of income not shown, create a CTRL+W worksheet using 
the Other (itemize) field on the INC screen.

Compensation and Wages
Enter shareholder compensation and employee wages on screen 3. Drake has two 
fields each for officer compensation and employee salaries/wages: one for non-share-
holders, and one for shareholders, as shown in Figure 2.

Figure 2: Compensation and wage fields on screen 3

Credit 
Adjustments

A credit adjustment is made for the following forms:

• Form 5884, Work Opportunity Credit
• Form 8844, Empowerment Zone and Renewal Community Employment Credit
• Form 8845, Indian Employment Credit

The adjustment is indicated on Form 1120S with the ATT_SSW literal. Actual adjust-
ments are shown on the ATT_SSW worksheet in View mode (Figure 3).

Figure 3: ATT_SSW literal on Form 1120S

NOTES
The Salaries and wages paid to non-shareholder employees field is 
an adjustment field. An amount entered here is combined with any 
amount entered in the Labor hired field on screen F.
The shareholder fields are used for calculating section 179 income limi-
tations; see the WK_S179L worksheet in View mode.
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Repairs and Maintenance
Enter repair and maintenance costs on screen 3. An amount entered there is combined 
with the amount, if any, entered in the Repairs and maintenance field on screen F.

Bad Debts
Use the Bad debts field on screen 3 to enter the total debts that became worthless in 
whole or in part during the year, but only to the extent that such debts related to a trade 
or business activity.

Rents
Use the Rents field on screen 3 to enter the rent that was paid on business property 
used in a trade or business activity. If a vehicle was rented, complete the 4562 screen 
for the vehicle.

Taxes and Licenses
Enter tax and license amounts on the TAX screen. Amounts are combined and the sum 
generated on Form 1120S, line 12 (“Taxes and licenses”). Note that credit from Form 
8846 (Credit for Employer Social Security and Medicare Taxes Paid on Certain 
Employee Tips) adjusts the line 12 amount. These amounts also appear on the “Taxes 
and Licenses Attachment,” referred to on line 12 with the printed “ATT_STL” refer-
ence. (Figure 4.)

Figure 4: Notification on line 12 of the 1120S return that the
Taxes and Licenses Attachment has been produced with the return

To keep the notification from appearing on line 12 of the return, go to the PRNT 
screen and select Suppress printing of form and attachment references.

State tax amounts (income tax and franchise tax) entered on the ES (Estimated Taxes) 
screen are carried to the tax computation (ATT_TAX) worksheet. The state tax 
amount carried from the ES screen may differ depending on which method of 
accounting (cash or accrual) is used.

NOTES
Enter deductible non-business bad debts as a short-term capital loss on 
Schedule D (Form 1120S).
Cash-method corporations cannot take a bad debt as a deduction 
unless the amount was previously included in income.

NOTE The Rents field is an adjustment field. An amount entered here is com-
bined with the amount, if any, entered in the Rent fields on screen F.
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Interest
Using the 1120S instruction guidelines, enter interest expense on screen 3. Note that 
the Interest expense field is an adjustment field. Any amount entered here is com-
bined with the amount, if any, entered in the Interest fields on screen F.

Depreciation
Enter depreciation on the 4562 screen. Select a form from the For drop list to associ-
ate the depreciable item with the correct form or activity. Data from the 4562 screens 
is calculated and carried to Form 1120 and to the selected schedules or forms.

For more information on depreciation and the 4562 screen in Drake, see the Drake 
Software User’s Manual: Tax Year 2010.

Line 14, 
Depreciation

Line 14 of Form 1120S is reserved for depreciation that (1) is from Form 4562, and 
(2) is not claimed on Schedule A or elsewhere. While the program pulls data from the 
4562 screen for this line, it also provides field 14b on screen 3 specifically for depre-
ciation that is claimed elsewhere (other than Schedule A) (Figure 5).

Figure 5: Line 14, Depreciation (on screen 3)

Both lines 14a and 14b on screen 3 are adjustment fields.

• Line 14a — See field-level help for further instructions and information on 
how this field ties in to Form 4562.

• Line 14b — Drake recommends entering depreciation on the 4562 screen, 
and then selecting COGS from the For drop list at the top of the screen. You 
can also use screen A (rather than screen 3) to enter depreciation claimed on 
Schedule A. An entry on screen A adjusts any entry on line 14b of screen 3 
and is calculated into the total deductions for page 1 of the 1120S. If there is 
an entry on line 14b but not on screen A, only the line 14b amount will be cal-
culated into total deductions.

Depletion
Enter depletion amounts on screen 3. Omit timber (use Form T, Forest Activities 
Schedules) and oil and gas properties. (Each shareholder should figure depletion.)

Advertising
Enter advertising expenses on screen 3.
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Pension and Profit-Sharing
The software reduces the expense based on the credit amount calculated from Form 
8881, Credit for Small Employer Pension Plan Startup Costs.

Other Deductions
Enter all other deductions on the DED screen. Drake incorporates the total into line 
19, Other deductions, on Form 1120S.

The following deductions, credits, adjustments, and exclusions also flow to line 19:

• Amortization from Form 4562
• Credit adjustment from Form 8820, Orphan Drug Credit
• Exclusion from Form 8873, Extraterritorial Income Exclusion
• Credit from Form 8941, Credit for Small Employer Health-Insurance Premiums

Tax and Payments
Screen 4 has fields for completing the “Tax and Payments” section of Form 1120S. 
Note that some fields are overrides. Press F1 to view more information on a field.

Net Passive Income

Line 22a, “Excess net passive income or LIFO recapture tax,” could apply to an S cor-
poration if it was formerly a “C” corporation or if it engaged in a tax-free reorganiza-
tion with a “C” corporation.

To determine if the corporation must pay the tax, complete the worksheet fields on 
screen 4. If completing the IRS worksheet, enter the worksheet results on screen 4. 
Enter LIFO recapture directly on screen 4.

Schedule D
Use screen D to enter data for Parts I and II of Schedule D (Form 1120S), Capital 
Gains and Losses and Built-in Gains. Use the DTAX screen for Part III of Schedule D 
(Form 1120S). For information on using the Schedule D import feature in Drake, see 
“Schedule D Imports” in Chapter 5 of the Drake Software User’s Manual: Tax Year 
2010.

2010 Estimated Tax
The 1120S does not have a federal estimated tax voucher. Estimated tax payments are 
required only in certain situations. An S corporation must make electronic deposits of 

NOTE To force the line 22a worksheet to be printed, select the applicable box 
on screen 4.
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employment, excise, and corporate income taxes using the Electronic Federal Tax 
Payments System (EFTPS).

Use the ES screen to enter estimated tax payments made for tax year 2010 and esti-
mated amounts for tax year 2011. Future year amounts appear on the ES_SUM work-
sheet generated with the return.

Payments with Extensions
To make a payment with an extension request, enter the amount being paid on the 
7004 screen. If an extension was previously requested and a payment was made then, 
enter the amount paid on screen 4, line 23b.

Tax Paid on Fuels
Use screen 4136 to enter information for Form 4136, Credit for Federal Tax Paid on 
Fuels. Note that this screen actually consists of two screens, with lines 1 through 8f on 
the first screen. Press PAGE UP or PAGE DOWN to go from screen to screen.

Estimated Taxes
Use the ES screen to enter federal and state estimated taxes paid in 2010. If the return 
was updated in Drake from 2009, this information is carried over. Note that this infor-
mation will be overridden by any entry in the Current-year estimated tax payments 
field on screen 4.

Estimated Payments for 2011
Use the ES screen for 2011 estimated payments. To enter the amount to be credited, 
used the OP to 2011 field. Note that this information will be overridden by any entry 
in the Amount to be credited to next year’s estimated tax field on screen 4.

Underpayment of Estimated Tax
For underpayment of estimated tax, complete all applicable fields on screen 2220.

Direct Deposit of Refunds
The IRS requires that Form 8050, Direct Deposit of Corporate Tax Refund, be submit-
ted with an e-filed return in order for a corporate refund to be directly deposited. To 
complete this form in Drake, use the DD screen (Figure 6).

Figure 6: Federal section of DD screen (also 8050 screen)
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When filling out the DD screen:

• If the federal refund is to go to the account listed, select Yes for the Federal 
Account selection; otherwise, select No. (Default is Yes.)

• If a state refund is to go to the account listed, select the state abbreviation from the 
State/city selection drop list.

• Enter the name of the financial institution, the routing number (RTN), the account 
number, and the type of account (Checking or Savings).

• Re-enter the RTN, account number and type of account to verify.

If receiving refunds from different state tax authorities, use the State Account boxes 
on the DD screen to indicate where other state refunds should be deposited.

International ACH Transactions
In 2009, state taxing agencies added foreign account questions to their forms to com-
ply with NACHA rules regarding International ACH transactions (IAT); however, 
processing IAT is not yet supported by any federal or state tax authority at this time. If 
you were to indicate that the account was outside the U.S., the state tax authority 
would automatically ignore the account information and either issue a refund via 
paper check, or contact the taxpayer requesting the payment of a balance due via 
check or domestic bank account. If you indicate that an account is located outside of 
the U.S., Drake Software generates a message page instructing you to choose an 
account located in the U.S.

For more information, see Screen Help on the DD screen and PMT screens.

Electronic Funds Withdrawal (Direct Debit)
Use the PMT screen, accessible from the General tab, to indicate that the balance due 
for an e-filed return should be withdrawn (direct-debited) from an account.

Program Defaults and Overrides
By default, the program indicates that the entire balance due (the “Amount owed” sec-
tion of Form 1120S) is to be withdrawn on the return due date. To indicate otherwise, 
complete the Requested payment date override field(s) for the applicable payment.

If the return is e-filed on or before the due date, the requested payment date cannot be 
later than the due date. If the return is transmitted after the due date, the requested pay-
ment date cannot be later than the current date.

Required Information
A Withdrawal selection (item 1 in Figure 7) is required if the program is to direct tax 
authorities to withdraw funds from the taxpayer’s account.
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Figure 7: Required fields on PMT screen: withdrawal selection (1);
account information (2); specified return (3)

The name of the financial institution, routing number (RTN), account number, and 
account type are required. As with the DD screen, the RTN, Account number, and 
Type of account data must be entered twice (item 2 in Figure 7).

Finally, the PMT screen must indicate the return to which the payment data applies 
(item 3 in Figure 7). Put a check mark in the box of the applicable return type.

Withdrawal from Multiple Accounts
Only one account can be designated for direct debit of funds for payment of federal or 
state taxes. To have state amounts withdrawn from an account other than the account 
indicated for federal payments, complete the fields in the State Account sections of 
the PMT screen. 

Filing an Extension
Calendar year returns are due on March 15, 2011. By filing Form 7004, an S corpora-
tion can extend the deadline six months to September 15. Fiscal year returns are due 
on the 15th day of the third month after the end of their year. Form 7004 extends the 
deadline six months.

To file an 1120S extension, use either of the following options:

• Go to the 7004 screen in Drake and select Generate an extension. Complete any 
other applicable fields on the screen.

• Go to the PRNT screen and select Prepare Form 7004 based on screen 1 data.

Signing the Return
Electronic (PIN) signatures are required for e-filed returns. If e-filing a return, com-
plete all fields on the PIN screen. A return cannot be e-filed if the PIN screen is not 
completed, including the title and signature (name) of the officer signing the return. 

NOTE Neither the federal nor the state balance due can be paid from more 
than one account.
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An 1120S return must be signed and dated by one of the following individuals:

• The corporation’s president, vice president, treasurer, assistant treasurer, or chief 
accounting officer

• Any other corporate officer, such as a tax officer, who is authorized to sign

If the return is prepared by a paid preparer, the preparer must complete the required 
information and sign the return in the space provided. If it is prepared by an employee 
or officer of the corporation, select NONE in the Firm # and Preparer # fields on 
screen 1.

To have the preparer’s name and address information displayed on the printed return:

• If the return preparer and ERO (entered in Setup > ERO) are the same:
– Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signa-

ture box is marked for the preparer.
– Complete the PIN screen for the return.

• If the return preparer and ERO are not the same:
– Go to the PRNT screen for the return and complete the field labeled PIN for 

preparer’s alternative electronic signature. The PIN entered should match 
the one entered for the preparer in Setup > Preparer(s). (For more informa-
tion, press F1 in this field.)

Amending a Return
New in 2010, amended 1120S can be e-filed using Drake Software.

To file an amended 1120S return:

1. Go to screen 1 and select Amended return in section H.
2. Make changes as applicable to forms and schedules.
3. Go to the EF screen and mark the 1120S check box on the left side of the screen.
4. Go to the AMD screen and list the changes that have been made, along with an 

explanation for each change. Use a different AMD screen for each line of the 
1120S. Press PAGE DOWN to open a new AMD screen.

If amending just the K-1s, go to each applicable K1 screen, select Amended K1, and 
make needed changes.

NOTE Setup > ERO must still be completed for e-filing. See the IRS instruc-
tions for further details on signature requirements.

CAUTION

When you amend a return in Drake, the amended information 
replaces the original in the data file. Before amending a return, you 
should archive the original to avoid losing previously submitted data. 
For more information on archiving returns, see “Archive Manager” in 
Chapter 6, “Return Results,” of the Drake Software User’s Manual: 
Tax Year 2010.
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Additional Information
This section covers Schedule B (Other Information), state-specific information, and 
some program overrides.

Schedule B
Enter the accounting method, principal business activity, and product or service on 
screen 1. This information (questions 1 and 2 of Schedule B) flows to Schedule B.

Use screen B to answer questions 3–8 of Schedule B. If the S corporation owned, 
directly or indirectly, 50% or more of the voting stock of a domestic corporation, 
select Yes for question 3 and click the B3 link to enter information about the domestic 
corporation owned. (You can enter information for up to 15 corporations per B3 
screen; to add more, click PAGE DOWN.)

State-specific Information

Resident 
State

The program automatically generates a return for the corporation’s resident state. Use 
screen 2 to enter company information as it should appear on the state return.

Company information includes the type of return that applies for state purposes (con-
solidated, composite, controlled group, multi-state) and state-specific dates and num-
bers for identification.

Other States Data for other states must be entered manually in state data entry. To access state data 
entry, select the States tab from the return menu and choose a state.

Contact 
Information

If certain contact information required for state purposes is different from that entered 
on screen 1, use screen 2 for the alternative data for any of the following entities:

• Registered office
• Principal place of business
• “Books in care of”
• General contact information

Screen 2 also has fields for the name, title, e-mail address, ID number, and telephone 
number of the S corporation’s contact person.

NOTE
When amending an 1120S return, all K-1s are amended, and the 
“Amended K-1” box on the return marked, by default. To override this 
default, go to the PRNT screen and mark Do NOT check amended 
box on Sch. K-1. (See Figure 9 on page 18.)

NOTE The company information fields on screen 2 apply for the resident state 
only.
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Officer 
Information

Screen E, Officer Information, is for state purposes only. Nothing entered on this 
screen is carried to the federal return.

Other Information and Overrides
Use screen 1 to enter the following additional information:

• Resident State — If the corporation has a mailing address in one state but does 
business in another, select the state in which the corporation does business from 
the Resident State drop list.

• Drake Codes and Overrides — Information on miscellaneous codes, invoice 
numbers, and override fields is covered in the Drake Software User’s Manual: Tax 
Year 2010.

Schedule K: Shareholders’ Pro Rata Share Items
Screen K, which consists of three screens, can be used to enter data for Schedule K, 
Shareholders’ Pro Rata Share Items. Note the K fields are primarily adjustment fields. 
Press F1 (or use the right-click menu) to see what amounts are adjusted from else-
where in the program.

Navigation
Press PAGE UP and PAGE DOWN to navigate from one K screen to another. There are 
three K screens:

• Shareholders’ Pro Rata Share Items (Income and Deductions)
• Credits & Credit Recapture & Foreign Transactions 
• Alternative Minimum & Other Information and Stock Transaction Dates

NEW FOR

 2010
An Address Line 2 field at the bottom of screen 2 is available for enter-
ing an alternative address. For example, if the address on screen 1 is a 
street address and the S corporation also has a P.O. box, you can enter 
the P.O. box information on screen 2.

TIP
The most commonly used Schedule K items can be answered on 
screen 3, Income and Deductions. If these amounts are entered on 
screen 3, they do not need to be entered on the K screens.

NOTE

Because charitable contributions are separately stated to the share-
holders, there is no “Charitable Contributions” line on the 1120S return. 
Charitable contribution information belongs instead on the Schedule K. 
Enter charitable contributions in the bottom third of screen 3 or in the 
line 12a - Contributions fields of the K screens. Any contribution limi-
tation is done at the shareholder level.
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Stock and Ownership Transaction Dates
Enter stock transaction dates on the third K screen (Alternative Minimum & Other 
Information and Stock Transaction Dates). This data ties into Schedule K-1, sec-
tion F. (See Figure 8.) When changes in shares are entered on the K-1, the program 
assumes that the changes occurred on the dates entered on the K screen.

For more detailed information about entering shareholder ownership changes, see 
item P, “Entering Shareholder Ownership Changes,” in the 1120S program FAQs, 
accessible from any tab in the Data Entry Menu.

Schedule K-1 for 1120S (Shareholder Information)
Use the K1 screen to enter data for Schedule K-1, Shareholder’s Share of Income, 
Deductions, Credits, etc.

Percentage Ownership
For percentage of stock ownership (see Figure 8), enter the number representing the 
change in shares on the applicable stock transaction dates (as entered on the third 
screen K; see “Stock and Ownership Transaction Dates,” previously).

Figure 8: Screen K1, “Percentage of Stock Ownership” section

Do not enter percentages in the Change in shares fields; percentages are calculated 
by the program based on the numbers entered in section F (Figure 8). A percentage 
should be entered only if the program calculations must be overridden; enter the per-
centage in the Shareholder’s % of stock ownership override field at the bottom of 
section F.

IRS K-1 Codes
A code sheet can follow the printing of each Form 1120S K-1 to help interpret the var-
ious codes used on Schedule K-1. In Drake, this is the 1120SK_1.PG3 sheet. To have 
this sheet printed with all K-1 schedules, go to Setup > Options > Form & Schedule 
Options tab and mark the Print Page 2 of Schedule K-1 check box. The codes can 

NOTE
The program calculates stock ownership changes for only four transac-
tion dates. If more than four changes are necessary, the shareholder's 
annualized percentage must be calculated outside of the program and 
the applicable amounts reported on each shareholder's K-1 and 
entered on the K1 screens as overrides.
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also be printed for a specific return by marking the applicable box on the PRNT 
screen, and are available from Tools > Blank Forms. 

The generated Schedule K-1 may include asterisks with letter codes.

• An asterisk with a letter code indicates that multiple items have that code.
• An asterisk at the bottom of a group indicates that there are more items than can fit 

in the space provided for that group and that a statement is attached, or that the 
statement is required (as in the case of “other” amounts).

Multiple Shareholders
For returns with a large number of shareholders, you have the option to deactivate cal-
culation and printing of the K-1s while working on the Form 1120S. This option, 
which eases the process of reconciling the 1120S, is available by going to the PRNT 
screen and marking the box under K-1 Items to Suppress (Figure 9).

Figure 9: Check box for suppressing K-1 items (located on PRNT screen)

When the return is ready to be filed, return to the PRNT screen and remove this check 
mark before calculating the return.

 Override Fields
It is not possible to override the calculations for a single shareholder. To override cal-
culated data, it is necessary to override the calculated amount on all K-1 schedules.

Foreign Addresses 
If the shareholder has a foreign address, enter Province (or State), Country, and 
Postal Code information in the Foreign Address ONLY address line of the Name 
and Address Information section (along with the street address and city in the 
Address and City fields). Do not enter anything in the U.S. State or ZIP fields. Con-
versely, for a U.S. address, do not enter anything into the foreign address fields

K-1 Export
Take the following steps to export a K-1 from an 1120S return into a 1040 return:

NOTE
Codes sheets are not displayed in View mode. If the 1120S K-1 is 
selected for printing, it is printed first, followed by the statements per-
taining to that 1120S K-1. These are followed by the code sheets.

IMPORTANT Shareholder overrides should not be done for an S corporation 
except in certain circumstances, such as ownership changes.
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1. Ensure that K-1 data is entered in the 1120S and that the 1040 has been created. 
(The K1S screen in the 1040 does not have to be created beforehand.)

2. In the 1120S return, go to View mode.
3. Click K1 Export in the View mode toolbar. A list of SSNs that cannot be 

exported appears, as applicable.
4. Click Next to continue.
5. Select the SSNs to be exported by marking the boxes to the left of the SSNs.
6. Click Export. The K-1 data will be displayed in the 1040 return in the program.

Supplemental Info
Two types of supplemental information can be added to Schedules K-1:

• Supplemental data for all K-1s in a return
• Supplemental data for a single K-1 in a return

To add supplemental information “globally” (to all K-1s), from the Data Entry 
Menu, open screen K1G (Global Supplemental Information) and enter the informa-
tion in the Supplemental Information block. This information will appear on all 
printed shareholder K-1s.

To add supplemental information to an individual K-1, open a shareholder’s K1 
screen and click the blue Supplemental Info link at the top of the screen. In the Sup-
plemental Information pane (Figure 10), enter information pertinent to this share-
holder. When the return is printed, this information will appear only on this 
shareholder’s K-1.

Figure 10: In this example, the information entered on the K1S screen appears
only on the individual shareholder’s K-1.

Domestic Production Activities
An S corporation does not take the deduction for Form 8903, Domestic Production 
Activities Deduction. Because the deduction is subject to income limitations, this 
information must be reported on shareholders’ individual returns. Shareholders use 
the pass-through amounts to calculate their eligibility for the deduction.

NOTE
Basis information for individual shareholders should be entered in the 
1040 package in Drake; this information cannot be exported from the 
1120S package to a 1040 return. Such an import would override limita-
tions and carryovers calculated in the 1040 program.
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On the 8903 screen, if the Print K1-8903 for each shareholder box is not selected, 
the amounts flow to the K-1, line 12, with codes Q and R. When this box is selected, 
the information flows to the K-1_8903 instead of box 12 on the K-1. The K1_8903 is 
referenced on a statement. Code P is printed on line 12 of the K-1, which refers to 
domestic production activities information.

Review the screen 8903 screen-level help, and the 8903 instructions (accessible 
through the Screen Help button on the 8903 screen) to determine when the K1_8903 
in needed.

K-1 Cover Letters
K-1 cover letters can be produced to accompany each Schedule K-1 in a return. You 
can set up the global option to produce K-1 cover letters for all returns containing K-1 
schedules, or you can choose the option on a per-return basis.

Producing 
Letters for 

All Returns

To have the K-1 cover letters produced automatically with all applicable returns, go to 
Setup > Options. Under the Optional Documents tab, mark the box labeled Include 
K-1 letter with returns. The signature on the return can be indicated in one of two 
ways:

• By completing the Signature and Title fields on the PIN screen
• By completing the Name and Title fields on the K1L screen (entries here override 

entries on the PIN screen)

Producing 
Letters for 

Single 
Return

If no default has been set to produce K-1 cover letters with all returns, you can take the 
following steps to generate letters for a single return:

1. Open the return and go to screen K1L.
2. At the bottom of the screen, enter the name and title of the person who will be 

signing the K-1 cover letter.
3. (optional) Mark Do not print entity information ... at the bottom of the screen in 

order to prevent the corporation’s name and address from being generated in the 
header of the K-1 letter.

Once the required signing information has been entered, a K-1 cover letter will be 
generated for each shareholder receiving a K-1.

NOTES

Line 11 (“Income limitation”) of Form 8903 is not applicable for the S 
corporation because the income limitation is calculated at the share-
holder level.
“Form W-2 wages” (on the 8903 screen) refers to the corporation’s W-2 
wages paid that are applicable to the Domestic Production Activities 
Deduction.

NOTE
To have the corporation’s name and address generated for K-1 letters, 
go to Setup > Letters > Setup > Letterhead and Margins and select 
Use Firm Info on Letters.
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Editing the 
K-1 Letter

As with other letters provided by the program, you can edit the text to suit your office 
needs and style.

To edit the text of the K-1 letter:

1. From the Home window, select Setup > Letters. The Client Communications 
Editor is displayed.

2. Select Open > S Corporation > Sub S K-1 Cover to view the template of the S 
corporation K-1 letter.

3. Make any desired changes to the template.
4. Click Save.

Shareholder’s Adjusted Basis Worksheet

Use the Shareholder’s Adjusted Basis Worksheet (Basis Wks screen) to calculate a 
shareholder's new basis after increases and decreases are made during the current year. 
The basis of S corporation stock is adjusted on an ongoing basis (unlike for a “C” cor-
poration, where stock basis remains constant unless additional stock purchases are 
made or stock is sold). A shareholder’s beginning basis in S corporation stock is the 
original capital contribution.

The Basis Wks screen is accessible by clicking the Basis Wks tab at the top of the K1 
screen for a shareholder (Figure 11). (Access the K1 screen from the Data Entry 
Menu.)

Figure 11: K1 screen tab for accessing the Adjusted Basis Worksheet

TIP
Review the following sections of the Drake Software User’s Manual: 
Tax Year 2010 before making changes to letter templates:
- “Introduction to Letters in Drake” in Chapter 2, Installation & Setup
- The “Letter Keywords” section of Appendix C, Keywords

NOTE
For an amended return, the K-1 letter automatically refers to the 
amended K-1. To edit the letter for an amended K-1, select Open > S 
Corporation > Sub S K1 Amended and follow steps 3 and 4 of the 
previous procedure.

NOTE
Basis information for individual shareholders should be entered in the 
1040 package in Drake; this information cannot be exported from the 
1120S package to a 1040 return. Such an import would override limita-
tions and carryovers calculated in the 1040 program.
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Increases 
and 

Decreases

Increases to basis can include additional stock purchases and capital contributions, 
separately stated income (including tax-exempt income), and depletion in excess of 
basis of property.

Decreases to basis can include distributions of cash or property to shareholders, sepa-
rately stated losses and deductions, nondeductible corporation expenses, and credit 
adjustments.

Annual 
Update of 

Shareholder 
Information

When the program is updated to the next tax year, the end-of-year basis and share-
holder loan amounts are automatically updated to the beginning of the new year. Any 
loss/deduction carryover is updated to the beginning of the year and its character 
(ordinary loss, section 179 expense, charitable contributions, etc.) maintained. The 
program also tracks the amount of debt applied to losses and the total amount of loss 
carryforwards.

Schedule L: Balance Sheet Per Books
Schedule L is required if the corporation’s total receipts for the tax year or its total 
assets at the end of the year is greater than $250,000.

Flow of Information
Many of the entries made elsewhere on the return flow automatically to the generated 
Schedule L (for example, inventory information from the Schedule A). Depreciable 
asset information from the 4562 screen and intangible assets and amortization also 
flow to Schedule L. 

The SCH2 Screen
The SCH2 screen is used to provide detailed information required by the IRS for cer-
tain lines on Schedule L. This screen can be used in place of the actual L screen in 
Drake. In other words, if you use this screen for all applicable lines on Schedule L, 
you do not need to make any entries on the L screen.

NOTE If a K1 screen is marked as final, none of the related screens for that 
shareholder are updated for the next year.

NOTES
To force the program to print Schedule L even if not required, go to the 
PRNT screen and select Force-print Schedules L and M-1.
With the Trial Balance Import feature, you might not need to use screen 
L at all. See “Importing Trial Balance Information” on page 38.

NOTES
All line selections are carried to the SCH2 screen in next year’s pro-
gram when the returns are updated. Line descriptions are updated, with 
the year-end amounts carried to the beginning-of-year column.
To access the SCH2 screen from the L screen, click the SCH2 Screen 
link on lines 6, 9, or 14 (or press CTRL+2).
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To create a statement for a line, select a line from the drop list and enter descriptions 
and their corresponding amounts. Once the information is entered, or if additional 
descriptions are required for the line, press PAGE DOWN to access a new screen.

Statements The total amounts entered on the SCH2 screen do not show up on the actual L screen 
in the program. They are, however, printed on the return as applicable, with references 
to the corresponding statements.

The type of statement produced by the program depends on the selected line and the 
IRS requirements. If a line is required, a statement labeled “STATEMENT” is pro-
duced and is e-filed with the return. If a line is not required, a statement sheet 
(“STMT”) is produced and is not e-filed with the return.

Note that an e-fileable “STATEMENT” is referenced in the return, as shown in the 
example of Figure 12.

Figure 12: Data entered on the “Other current assets” line will be attached as an
e-fileable statement and referenced on the applicable line of the return.

SCH2 and 
Trial Balance 

Typically, one or more SCH2 detail screens are needed for Schedule L items. If you 
are using Drake’s trial balance worksheet feature, be aware that data for the SCH2 
screens cannot be entered directly into the trial balance worksheet, and it cannot be 
imported into the data entry. The SCH2 detail screens must be created apart from the 
trial balance worksheet.

When the return is produced, Schedule L reflects both the amounts imported from the 
trial balance worksheets (where direct entry was allowed) and the totals of the SCH2 
screen amounts.

For more information, see “SCH2 Detail” on page 45.
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Autobalance
Autobalance forces Schedule L to balance for both the beginning- and end-of-year 
amounts. The program adjusts the unappropriated retained earnings amount on Sched-
ule L by the difference between the total assets and the total liabilities and capital 
before the adjustment.

(Example: If Assets = $1,000, and Liabilities and Capital = $900, the program 
increases the unappropriated retained earnings by $100.)

The program makes the adjustment due to differences in the balance sheet. These dif-
ferences can come from amounts entered incorrectly but are usually the result of one 
of the following causes:

• An asset was deleted from the 4562 screen (Depreciation Detail) instead of being 
indicated as sold.

• Beginning inventory amounts were adjusted on Schedule A, or ending inventory 
amounts were entered incorrectly.

• Amounts were erroneously deleted or changed from screen L.

To reconcile the differences, it is best to compare the corporation’s beginning and end-
ing balance sheet amounts for the tax year.

To deactivate the autobalance feature for a specific return, go to the PRNT screen and 
select Turn off autobalance.

Schedules M-1, M-3 (Reconciliation of Books/Return)
Schedule M-1 is required if the balance sheet’s total assets at the end of the year are 
greater than $250,000. Schedule M-3 is required if the balance sheet’s total assets at 
the end of the year equal or exceed $10 million.

Schedule M-1
Schedule M-1 shows all items of income and expense that are not subject to tax, plus 
those accounting items that are not income tax items. When required, taxpayers must 
reconcile book income with taxable income.

Use the M1 screen to enter book-to-tax difference for Schedule M-1. Book-to-tax dif-
ferences are classified as permanent or temporary, and as favorable or unfavorable. 
Examples of both kinds of differences are shown in Table 1.

NOTE
If the S corporation is filing Schedule M-3, and there are entries on the 
M1 screen, it’s best to delete the M1 screen. To do so, open the M1 
screen and press CTRL+D. 
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Depreciation 
and 

Amortization 
Adjustments

The program may make an adjustment for book-to-tax depreciation (or amortization) 
differences. The calculation is done with the following steps. (This procedure refers to 
“depreciation” throughout, but it applies for either depreciation or amortization.)

1. The amount reported on Schedule L “Beginning of Year” accumulated deprecia-
tion (line 10b, column a) is subtracted from the “End of Year” accumulated depre-
ciation (line 10b, column c). This is the “book” depreciation amount.

2. This “book” depreciation amount is compared to the “tax” depreciation amount. 
(The “tax” depreciation amount is calculated from the Form(s) 4562, including 
any section 179 amounts.)

3. The difference between the “book” and “tax” depreciation amounts is carried to 
the appropriate form and line.
• If the “book” depreciation amount is greater than the “tax” depreciation 

amount, the difference is carried to one of the following locations:
– Schedule M-1, line 3a
– Schedule M-3, Part III, line 24 (as a negative amount)
– Form 8916-A, line 2l (as a negative amount for assets selected on the 

4562 detail screen for COGS)
• If the “tax” depreciation amount is greater than the “book” depreciation 

amount, the difference is carried to one of the following locations:
– Schedule M-1, line 6a
– Schedule M-3, Part III, line 24 (as a positive amount)
– Form 8916-A, line 2l (as a positive amount for assets selected on the 4562 

detail screen for COGS)

Schedule M-3
Any domestic corporation or group of corporations that report on Schedule L of Form 
1120S total assets at the end of the S corporation’s tax year that equal or exceed $10 
million must complete and file Schedule M-3 instead of Schedule M-1. If the S corpo-

Table 1: Examples Book-to-Tax Differences for Schedule M-1

Difference Description Examples

Permanent Book or tax items that will never be 
reported for book or tax purposes

- Meals & entertainment limitations
- Penalties
- Tax-exempt interest

Temporary Items that will be reported for both 
tax and book purposes, but not dur-
ing the same tax year

- Depreciation
- Gains or losses on the sale of 

depreciated assets

Favorable Items that reduce taxable income - Instances in which tax depreciation 
amount is greater than book depre-
ciation amount

Unfavorable Items that increase taxable income - Disallowed meals & entertainment
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ration is required to file (or voluntarily files) Schedule M-3, it must file Form 1120S 
and all attachments and schedules, including Schedule M-3.

Accessing 
the M3 

Screens

The Schedule M-3 section of the Data Entry Menu provides direct access to the fol-
lowing screens:

• M3, M32, and M33 — for Parts I, II, and III of the Schedule M-3
• M3S — for supplemental statements
• SCH3 — for subsidiary schedules for Schedule M-3 and Form 8916-A
• 8916A — for Form 8916-A, Supplemental Attachment to Schedule M-3

Certain income, deductions, gains, and losses flow from the 1120S to the M-3 in the 
program, but all other M-3 data must be entered manually on the M3 screens.

The SCH3 
Screen

The SCH3 screen is similar to the SCH2 screen and is used to provide detailed infor-
mation for Schedule M-3 and Form 8916-A. It can be used in place of the actual M3 
and 8916A screens.

For more information on using this type of screen, see “The SCH2 Screen” on 
page 22.

Schedule M-2 (Analysis of Accounts)

For an S corporation return, Schedule M-2 is the analysis of the Accumulated Adjust-
ment Account. Schedule M-2 information can be entered on the M2 screen and else-
where in the program, but most information is carried to the M-2 automatically. See 
“Entering Distributions,” following.

Schedule M-2 represents a corporate picture of the income, losses, and distributions to 
shareholders and tracks tax-free distributions and helps determine if excess distribu-
tions might be taxable to shareholders. If a shareholder receives more in distributions 
than he or she has in basis, the result might be taxable.

Entering Distributions
Code Section 6037 states that an S corporation return must report the amount and date 
of distributions made to each shareholder. New in 2010, the DIST screen is used for 
entering date and distribution amounts for Schedule K, line 16d, Distributions. In 
addition to line 16d, the total from the DIST screen may flow to Schedule M-2, line 7 
(subject to limitations) and to the Schedules K-1 based on the shareholder’s ownership 
percentage. Schedule K-1 distribution information is displayed on the K1_DIST 
worksheet produced with the return.

NOTE
Parts II and III of Schedule M-3 reconcile financial statement net 
income (loss) for the U.S. tax return (per Schedule M-3, Part I, line 11) 
to total income (loss) on Form 1120S, page 3, Schedule K, line 18.

NOTE On an 1120S return (unlike an 1120 return), Schedule M-2 is not a rec-
onciliation of retained earnings. 
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Column A, Accumulated Adjustments Account
The Accumulated Adjustments Account (AAA) column generally reflects the S cor-
poration’s accumulated undistributed net income after 1982. Non-dividend distribu-
tions flow to Schedule M-2 from Schedule K, line 16d. An entry in the Non-dividend 
distributions field (line 7) of the M2 screen adjusts the amount from the K screen 
(subject to limitations; see balance-sheet examples on the following page).

Distributions reported on line 7 flow differently from the amount entered on the DIST 
screen. (See the previous section, “Entering Distributions.”) The distributions are lim-
ited following the ordering rules under Reg §1.1368.2.

These rules are for Schedule M-2, Column a:

• Line 1 balance — The balance at the beginning of tax year, line 1 is either 
zero or the balance carried forward from line 8 of the previous year. Due to 
prior-year net losses and reductions, the amount on line 1 can be negative.

• Changes to AAA — The AAA is increased for ordinary income from page 1, 
line 21 (line 2) and other additions listed on line 3. The AAA is then 
decreased for any loss from page 1, line 21 (line 4) and other reductions listed 
on line 5.

• Reduction of AAA — Once these adjustments are made, the AAA is reduced 
by ordinary distributions on line 7, but not less than zero. Thus, if the distribu-
tions are $20,000, but the net amount on line 6 is $10,000, line 7 is limited to 
$10,000. If line 6 is a negative number, then line 7 will be zero (in this exam-
ple). To allow an amount on this line would take the AAA to a larger negative 
number. (That is, even more below zero than it really is).

The rules from the preceding chart apply when the net adjustment for lines 2 through 5 
is positive. When the net adjustment for lines 2 through 5 is negative, the ordering 
rules are switched and AAA is decreased by ordinary distributions (but not below 
zero) before the net negative adjustment for lines 2 through 5.

TIP See Form 1120S instructions for more details and examples.
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Important 
Note about 

the AAA

A corporation can make distributions greater than the amount on line 6 of the M-2, but 
those distributions could be taxable to the shareholders. Enter distributions on the 
DIST screen; this way, the amounts flow automatically to Schedules M-2 and K-1 but 
are limited based on the rules described previously. (For more information on the 
DIST screen, see “Entering Distributions” on page 26.)

Line 7 is limited to the lesser of the amount for line 7 or the positive amount from line 
6. If line 6 is negative, line 7 is then limited to the positive amount on line 1. If line 1 
and line 6 are both negative, line 7 is completely disallowed on the Schedule M-2. 
Distributions are entered on the DIST screen to be reported to the shareholders, 
regardless of the Schedule M-2 limitation.The AAA cannot be negative as a result of 
distributions, but it can be negative if it arises from losses.

Column B, Other Adjustments Account
Use Column B to enter any amounts you want printed in the corresponding column in 
the printed return. Officer life insurance and applicable tax-exempt income flows to 
Schedule M-2, Column B (“Other adjustments account”), line 5. All other amounts 
(such as expenses) must be entered manually on the M2 screen.

Column C, Undistributed Taxable Income Previously Taxed
The total of Column C cannot be negative. This column is active in an 1120S only if 
the entity was ever a “C” corporation (thus having earnings and profit (E&P)) or if it 
was a pre-1983 S corporation. By design, Drake does not allow negative numbers in 
Column C.

If a corporation becomes an S corporation and has net operating losses (NOLs), the 
NOL is not generated for the return because it cannot be carried to an 1120S (the IRS 
does not want the NOL to be used by the shareholders to offset income); it either runs 
out within the years allowable for the NOL by statute or is used if the S corporation 
terminates its “S” status within those years.

Rental Activities
Income and expenses for rental real estate properties appear on Form 8825, Rental 
Real Estate Income and Expenses of a Partnership or an S Corporation. To make 
entries in Drake, use the 8825 screen.

If there are multiple 8825 properties, press PAGE DOWN for a new 8825 screen. Use 
one screen per rental property. If a return has more than one 8825 screen, the program 
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reports each property’s information on a separate column of Form 8825 (up to eight 
properties can be included on a form). Data from all 8825 screens are transmitted to 
the IRS when the return is e-filed.

Line 14, Depreciation
If the program is calculating depreciation (entered on the 4562 screen) for the property 
listed on Form 8825, do not enter the depreciation on the 8825 screen. Depreciation 
should be entered only if it is figured outside of the Drake program, and then the net 
results should be entered on screen 8825. The amount entered on line 14 is added to 
the depreciation calculated from the 4562 screens.

Carrying 
Information 

to Form 8825

To indicate that the information should be carried to Form 8825, select 8825 from the 
For drop list on screen 4562. If there are multiple 8825 screens, use the Multi-form 
code box. For information on using the Multi-form code box, see the Drake Software 
User’s Manual: Tax Year 2010.

Figure 13: In this example, the program will carry the 4562 information
to the third 8825 screen created.

Any depreciation information entered on the 4562 screen is carried to the correct 
Form 8825, based on the form and multi-form code selections at the top of the 4562 
detail screens.

Line 15, Other Expenses (list)
Enter meals and entertainment (subject to 50% limit) in the appropriate field on line 
15. To enter additional other expenses, begin typing into the Additional other 

NOTE Special steps are required if using the trial balance worksheet for multi-
ple rentals. See “Rental Expenses” on page 46.

NOTE Form 4562 is required for assets placed in service during the year.

IMPORTANT

When selecting a multi-form code, note that the code should refer 
to an 8825 screen—not the 8825 form. For example, data from 
the third 8825 screen will be generated on the first Form 8825. To 
associate an asset with that information, you would enter a “3” for 
the screen (not a “1” for the form) in the Multi-form code box. For 
more information on Form 8825, see “Viewing Rental Activity 
Information,” below.
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expenses field to open a Detail (CTRL+W) worksheet. Enter descriptions and amounts 
on this worksheet. 

A statement from each 8825 property is printed with the return and is submitted to the 
IRS when the return is transmitted.

Use the K1P screen to enter rental income the S corporation receives on a K-1. This 
amount is carried to Form 8825, lines 20a and 20b. No entry in required on the 8825 
screen.

Viewing Rental Activity Information
Rental activity data is viewed on the 8825 forms and accompanying statements.

• 8825 Forms — The two-page Form 8825 can contain information for up to 
eight rental activities. Each Form 8825 in View mode contains up to eight 
rental activities. If more are entered, a second Form 8825 is created.

Figure 14: Multiple 8825 pages are created if more than eight rental activities.

The Form 8825 in View mode consists of one or more pages (depending on 
the number of rental activities) listing up to four rental activities per page. If 
more than four rental activities are entered, scroll down to the second page of 
the Form 8825 when viewing.

• 8825 Statements — Statements are titled STM_8825_XX, where XX equals 
the instance of the 8825 screen. (For example, the statements for the first and 
second 8825 screens would be labeled STM_8825_01 and STM_8825_02, 
respectively.) There are also 8825 attachments (8825_ATT) for other report-
ing information.

Credits and Adjustments
Certain credits require an adjustment to either income or expenses. The program car-
ries the required adjustments to the appropriate line of the return and to either Sched-
ule M-1 or Schedule M-3.
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Manually reducing the expenses or deductions or increasing the income for these 
credits causes the return to be out of balance.

Adjustments are made to other income for the credit amounts for the following cred-
its:

• Form 6478, Alcoholic and Cellulosic Biofuel Fuels Credit
• Form 8864, Biodiesel and Renewable Diesel Fuels Credit
• Form 8912, Credit to Holders of Tax Credit Bonds (interest income)

Adjustments are made to the appropriate deduction or expense for the credit amounts 
for the following credits:

• Form 5884, Work Opportunity Credit
• Form 6765, Credit for Increasing Research Activities
• Form 8820, Orphan Drug Credit
• Form 8845, Indian Employment Credit
• Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Cer-

tain Employee Tips
• Form 8881, Credit for Small Employer Pension Plan Startup Costs
• Form 8844, Empowerment Zone and Renewal Community Credit
• Form 8912, Credit to Holders of Tax Credit Bonds
• Form 8941, Credit for Small Employer Health Insurance Premiums

Making Changes on the Fly
Use the PRNT screen to override program defaults.

Suppressing/Forcing Items
To suppress or force certain documents, go to the PRNT screen and select the desired 
options. Many “on-the-fly” changes will override the options established in Setup.

1120S Items These items can be “forced” (forcing the program to generate the item) on a return:

• Schedules L and M-1
• Form 4562 (Depreciation and Amortization)
• Next-year depreciation listing
• “Inactive return” printed on first page of the 1120S
• Preparer and officer signature on printed copy of return

The following 1120S items can be “suppressed” (kept from being generated) on a 
return:

• Schedule M-2
• WK_M2 (Retained Earnings Reconciliation Worksheet)
• Form and worksheet references
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K-1 Items The following K-1 items can be “forced” (forcing the program to generate the item) 
on a return:

• Shareholder’s adjusted basis worksheet (WK_SBAS)
• K-1 codes (page 2 of the Schedule K-1)

The following K-1 items can be “suppressed” (kept from being generated) on a return:

• Related documents: Schedule K-1, K-1 cover letter, K1_ATT worksheet (for K-1 
statement overflow), and shareholder’s adjusted basis worksheet (WK_SBAS)

• Marking of “Amended K-1” box on printed Schedule K-1

Overriding Other Setup Options
Filing instructions and envelope coversheets can be either forced or suppressed from 
the PRNT screen to override the global setting in Setup.

The PRNT screen also includes options to disable autobalance (see “Autobalance” on 
page 24), calculate the Form 2220 penalty, and prepare an extension (Form 7004) 
based on the data entered on screen 1 (see “Filing an Extension” on page 13).

Electronic Filing
Steps for e-filing Form 1120S are the same as for e-filing Form 1040, with the excep-
tion of bankruptcy returns, which must be paper-filed.

Calendar year returns are due on March 15, 2011. Fiscal year returns are due on the 
15th day of the third month (two and a half months) after the S corporation’s year end. 
Returns can be e-filed after these dates; however, if an extension has not been filed, 
penalties and interest are applied.

NOTE
Form and worksheet references are for the benefit of the preparer and 
client but are not required for the tax return. References appear on tax 
forms to clarify which worksheets (available in View mode) correspond 
to which calculations, and which forms/screens certain amounts are 
carried from.

NEW FOR

 2010
A default due date for filing is printed on all letters and filing instructions 
generated with a return. You can now override the default by entering 
an alternate due date in the Due date to print on letter and filing inst 
field on the PRNT screen.

NOTES

S corporations with $10 million or more in total assets that file 250 or 
more returns a year are required to e-file their Form 1120S returns.
Every 1099, W-2, 940, and 941 form that is filed is counted as part of 
the 250-return threshold. For example, if a corporation filing an 1120S 
return also files 150 W-2 forms, each W-2 would count as a separate 
return within the 250-return threshold.
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Additional Return Types
52–53-week year returns, inactive returns, and short-year returns can all be e-filed 
using Drake. For information on how to indicate a short-year return in Drake, see 
“Short-Year Returns” on page 4. Information on e-filing 52–53-week returns and 
short-year returns is provided in the following sections.

Electing a 
52-53–Week 
Year (Initial 

Return)

To elect a 52-53–week year, a new entity (one that has never filed a return) must enter 
data on both screen 1 and the ELEC screen.

To elect a 52-53–week year for any entity:

1. In the If not calendar year section of screen 1, enter the Fiscal year beginning 
and Fiscal year ending dates. Use MMDDYYYY format, as shown in the exam-
ple in Figure 15.

2. Mark the 52-53-week tax year box.

Figure 15: In this example, the fiscal year begins 12/30/09 and ends 1/1/11
(the Saturday closest to the end of December), giving the entity a 53-week year for 2010.

3. Click the ELEC link to open the Election Options screen (Figure 16).

Figure 16: Elections for 52-53-week tax years

4. For line 1, select the month in which the 52-53–week year ends for the current fis-
cal year. (01 = January, 02 = February, etc.)

5. For line 2, select the day of the week the tax year always ends.
6. For line 3, enter the actual date that the tax year ends (the same date entered in the 

Fiscal year ending field on screen 1).

In subsequent years, only the 52-53–week tax year check box on screen 1 must be 
marked; the program automatically updates the dates.

NOTE
An entity that has filed returns in the past must complete only steps 1 
and 2 of this process. An entity that has never filed a return before must 
continue with steps 3 through 6.

NOTE
Once a 52-53–week year is selected, the entity must use that account-
ing period every year. To change accounting periods, the entity must 
submit to the IRS Form 3115, Application for Change in Accounting 
Method.
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Inactive 
Returns

Entities that are inactive but are still required to file returns may e-file inactive returns 
in Drake. To indicate that a return is inactive:

1. Go to the PRNT screen, accessible from the General tab.
2. Under Items to Print, mark the Print inactive return box.

When the return is calculated, the program displays the words “Inactive Return” on 
the main form of the return (specifically, on lines 1c and 2). Zeros are displayed where 
required by the IRS in order for amounts to be properly included in the e-file data.

For detailed instructions on e-filing returns in Drake, see Drake Software User’s Man-
ual: Tax Year 2010.

Common Error Codes
If one or more of the following IRS error reject codes is generated when e-filing an 
1120S return, the preparer must contact the IRS for further information.The e-file help 
desk number is (866) 255-0654.

• Reject Code 239 — Filer’s TIN and Name Control in the Return Header must 
match data in the e-File database unless Form 1120S, Item H (2), Name Change 
box is selected.

• Reject Code 905 — Electronic Filing Identification Number (EFIN) in the Return 
Header must be listed in the e-File database and in accepted status. If you get this 
reject code, you must update your e-file application to include the 1120S return 
type (Figure 17). This can be done at the IRS website or by calling the IRS e-file 
Help Desk at (866) 255-0654.

Figure 17: The 1120 box must be marked in order to e-file Form 1120S.

Binary Attachments
Binary, or PDF, files can be attached to certain tax forms. These attachments are gen-
erally signature or third-party documents such as a copy of a signed lease or a signed 
appraisal statement. In some instances, the IRS requires that a document be attached 
to an e-filed return; in other instances, a document can be attached voluntarily to sup-
port or explain an entry in the return. In either case, a document must be printed, 

NOTE All EF messages must be cleared in order to e-file an inactive return.
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scanned into the computer (or “saved” as a PDF document), and attached to the return 
in order to be e-filed with the return.

You can attach PDF files to federal S corporation 1120S returns for e-filing. The PDF 
Attachments screen is accessible from the Data Entry Menu.

The PDF Attachment Process
Three main steps are involved in the PDF attachment process in Drake:

1. Creating a PDF document to be attached
2. Informing the program that a PDF document will be sent with the return
3. Attaching the PDF document for e-filing

These steps are described in the following sections.

Creating a 
PDF File

To create a PDF file:

1. Scan the document to be attached to the return.

2. Save the document to your client’s DDM file, your computer’s desktop, or any-
where you can readily find it.

Adding PDF 
Documents 

in Drake

To indicate in the software that a PDF document will be sent with the return:

1. Open the return in Drake. From the Data Entry Menu, click PDF Attachments 
(or type PDF in the selector field and press ENTER).

 
Figure 18: Select PDF Attachments, or type PDF into the selector field and press ENTER

2. Fill out the columns on the PDF Attachments screen. See Table 2 for examples.

TIP It’s a good idea to use the DDM scanning feature for this step.

NOTE
Many types of documents (for instance, documents created in Microsoft 
Word) can be printed or “saved” as PDF documents if you have a PDF 
printer (such as Adobe Reader) installed.
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3. Exit the PDF Attachments window.

Because you’ve indicated that a PDF document is attached, the program generates an 
EF message page regarding the attachment when the return is calculated.

Attaching 
Documents 

to the Return 

To attach a PDF file to a return:

1. From the return, click View. If anything was entered in the PDF Attachments 
window (see “Adding PDF Documents in Drake,” previously), there will be two 
PDF–related items in the View/Print window:
• A red MESSAGES alert (item #1 in Figure 19)
• An Attach PDF button on the toolbar (item #2 in Figure 19)

Figure 19: The red MESSAGES file and the Attach PDF button

2. Click the red MESSAGES file to view EF messages, including information on 
how to attach the required documents to the return.

3. Click the Attach PDF button. The EF PDF Attachments window displays the 
information entered on the PDF Attachments window in data entry. A red X 
means the document has not yet been attached; a green check mark indicates an 
attached document.

Table 2: PDF Attachment Window Columns

Name of Column Description Examples

Reference Source Name or number of regulation, 
publication, or form instruction that 
makes attachments necessary

- IRS Pub xxx-1.4
- Form Instructions for 1120S

Description Description of form or document to 
be attached

- Title of house on Oak Street
- Appraisal of Lot 1234

File name Distinctive, easily recognizable file 
name, followed by “.pdf”

- TitleHouseOakSt.pdf
- AppraisalLot1234.pdf
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Figure 20: The EF PDF Attachments window

4. Click the row of a document to attach.
5. Click Browse.
6. Browse to the proper folder, select the PDF file to attach, and click Open (or dou-

ble-click the file name).

Repeat for all documents with a red X. When all documents have been attached to a 
completed return, the return is ready to be e-filed.

Printing Generated Documents
In some instances, Drake generates a document that must be printed, signed, and 
scanned back into the computer to be attached to the return. For example, if Form 
2553, Election by a Small Business Corporation, is present in an S corporation return, 
message 1513 is generated when the return is calculated.

Figure 21: EF message page

As shown in Figure 21, the EF message states that attachments are required. You 
would then need to obtain or complete the statements, scan them into the computer, 
save them as a PDF document, and attach them to the return.
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Importing Trial Balance Information
Drake’s trial balance import feature allows data to be imported into an 1120S return 
from a trial balance worksheet. The trial balance template and importing function has 
the following benefits:

• Eliminates the need to duplicate entries
• Reduces data entry errors by automatically importing data to the correct fields
• Allows preparers to merge basic accounting functions with tax preparation

Preparing to Use Trial Balance Import
The trial balance import function can be used only on returns that were created in 
Drake 2008 or later. If you haven’t already, create a client file in Drake or update an 
existing client file from the prior year. Like several other functions of the tax software, 
this new feature requires Microsoft Excel (version 2000 or later).

In addition, take these actions to ensure the trial balance import works properly:

• Enable Macros — The trial balance import function uses macros in Microsoft 
Excel. Check your Excel settings to ensure that macros are activated and that 
macro security is set to “medium.” To do so, go to Tools > Options in Excel and 
select the Security tab. Click Macro Security and select Medium, then click 
OK.

• Disable Autobalance — (optional) When autobalance is disabled, the program is 
prevented from automatically adjusting the year-end retained earnings or capital 
amounts, thus allowing you to see any discrepancies in the balance sheet. To dis-
able autobalance, go to the PRNT screen and select Turn off autobalance.

Figure 22: Disable autobalance in the
Calculations and Other Options section of PRNT screen

• Force Schedule L — By default, the program does not display the balance sheet 
amounts on the return if the entity does not meet the filing requirement. If this is 

NOTE A flow chart of the trial balance importing process is available as an 
appendix at the end of this manual.

NOTE
In Windows 7 and in Microsoft Vista, click the Office button in the upper 
left and then click the Excel Options button at the bottom of the win-
dow. Next, select Trust Center from the list at left, then click the Trust 
Center Settings button. Select Macro Settings from the list on the 
left, then choose Disable all macros with notification. Click OK.
38 Tax Year 2010



Drake Software User’s Manual Supplement: S Corporations Importing Trial Balance Information
the case, you must override the default setting in order to have the amounts shown 
on Schedule L. To force the Schedule L amounts to be printed, go to the PRNT 
screen and select the Force-print Schedules L and M-1 box.

Figure 23: Force Schedule L box for 1120S package

• Check for Detail Worksheets — The trial balance import allows only those 
detail worksheets required by the IRS. Check updated returns for detail 
(CTRL+W) worksheets that are not required. For example, the IRS does not 
require a detail worksheet for the Gross receipts field on screen 3; if a return has 
a detail worksheet for that field, the trial balance will not be imported correctly 
into the return. Detail worksheets are indicated by red shading, as shown in 
Figure 24.

Figure 24: Example of an “unnecessary” detail worksheet

Remove unnecessary detail worksheets prior to import. See “Detail Worksheets” 
on page 41 for more information on using detail worksheets in the trial balance.

Preparing Financial Data for Import
To prepare the financial data for importing into the return, the data must be entered 
into Drake’s specially designed trial balance template. Once this information is 
entered and saved, it can be imported into the return.

Opening a 
Template

The first step in preparing financial data for importing is to open a trial balance tem-
plate for the return and enter the financial data.

To open a trial balance template for a return:

1. Open the return to the Data Entry Menu.
2. Click Import > Trial Balance Import in the menu toolbar. The preliminary Trial 

Balance Import dialog box is opened.

NOTE Wording of this option varies by return package. The example above is 
of the Force-print Schedules L and M-1 box for an 1120S return.
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3. Click Create New or Open Existing. If opening an existing file, click Open after 
selecting the correct file.

4. If a Security Warning box appears, click Enable Macros.

The trial balance template is displayed in Microsoft Excel.

Naming 
Convention

Whenever a new template is opened, the tax software assigns it a default file location 
and name. Trial balance templates are saved in the TB folder of your Drake10 soft-
ware. The file name consists of the client name as entered in Drake, plus “TB” for 
“trial balance,” plus the “.xls” suffix assigned to all Excel files, as shown in Figure 25.

Figure 25: Example of trial balance template file name

To change the name of a file in Excel, select File > Save As and assign the new name.

Template 
Structure

The trial balance template consists of three title rows and six columns. The Entity 
Name and Year End title rows can be edited; double-click a row to change the title. 
Columns are described in Table 3.

Displayed at the bottom of the trial balance worksheet are the calculated amount for 
Schedule M-1, line 1; the credit and debit totals; and a cell showing whether or not the 
balance sheet is out of balance and, if applicable, the out-of-balance amount 
(Figure 26; see also Figure 29 on page 42).

NOTE
In Microsoft Vista and Windows 7, you will see a Security Warning 
message with an Options button. Click Options to open the Security 
Options dialog box, then select Enable this content. Click OK.

NOTE
If saving a trial balance to a different location, make a note of where 
you’re storing it. The program automatically looks in the default direc-
tory.

Table 3: Trial Balance Template Columns

Column Description

Account Title Title of account

Debit/Credit Debit and credit amounts

Import to Screen and line in Drake to which the debit or credit 
amount is imported

Reported on: Form, Page, 
Sch, and/or line

Location of the amount on the printed return

Other information Additional details for preparers; see “Details for Pre-
parers” on page 44.
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Figure 26: Schedule M-1 amount (1); totals (2); and indication of balance (3)

Following are instructions and guidelines for using the trial balance template to 
assemble financial data for importing into data entry.

Entering Financial Data
When a new trial balance file is opened for a return, all debit and credit amounts are 
zero ($0). All data must be entered manually into the template.

Direct Entry Most cells in the trial balance worksheet are view-only. In a new template, editable 
debit and credit cells are indicated by a dollar amount ($0) and are not gray.

Detail 
Worksheets

Some cells require more detail than can be entered on a single line. These cells are 
indicated by buttons. (If these cells do not work, you may need to enable them; see the 
Note in “Opening a Template” on page 39.)

Figure 27: Example of cells that require worksheets

Click a worksheet button to open a worksheet in a new tab. Figure 28 shows an exam-
ple of the “Other Income” worksheet.

NOTE
Some data cannot be imported with the trial balance and must be 
entered directly into the data entry fields within the program. For more 
on these categories of data, see “Special Conditions” on page 44.
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Figure 28: Trial balance worksheet for “Other Income”

To return to the previous worksheet, click the TB tab (labeled “1” in Figure 28), or 
click the Return button above the worksheet tabs (labeled “2” in Figure 28). Note that 
a detail tab (the “Other Income” tab in Figure 28) might include one or more detail 
worksheets (labeled “3” in Figure 28).

Totals Totals are displayed at the bottom of each worksheet. If credit and debit columns are 
out of balance, the worksheet highlights the out-of-balance amount (Figure 29).

Figure 29: Out-of-balance amount is highlighted if columns are out of balance.

In addition to credit and debit totals, the main trial balance worksheet shows the net 
income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjust-
ments are made in the software.

NOTE
Do not create detail worksheets in data entry if the trial balance work-
sheet does not provide an equivalent detail worksheet, or the trial bal-
ance will not be imported correctly.

NOTE The data cannot be imported if the worksheet is out of balance.
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Saving a File
To save a file, click the Save icon or select File > Save from the menu bar. To re-name 
a file when saving, select File > Save As. For more information on file names in the 
trial balance program, see “Naming Convention” on page 40.

Importing Data into a Return
Once a trial balance worksheet has been set up for a client in Drake, the trial balance 
information can be imported into the program and calculated into the return.

To import a trial balance into a return:

1. Open the return to which you will import the trial balance information.
2. Click Import > Trial Balance Import from the menu toolbar. The preliminary 

Trial Balance Import dialog box is opened.
3. Click Next.
4. Enter or select the trial balance file to be imported. If necessary, click the button 

the right of 1. Import File Name to browse to the proper folder. By default, each 
trial balance file is an Excel (.xls) file showing the client name and ending in 
“TB” for trial balance, as shown in the example in Figure 30. (See “Naming Con-
vention” on page 40.)

Figure 30: Selected file to import

5. Select the Trial Balance Additional Import Options. (See “Additional Import 
Options” following this procedure.)

6. Click Next and wait for the import to be completed.
7. Click Finish.

The program returns to the Data Entry Menu for the open return. Note that all 
selected data from the trial balance worksheet has been imported into the return. This 
can be seen both in the data entry screens and on the generated return.

NOTES

Not all trial balance data can be imported directly into a return. For 
information on program limitations, see “Special Conditions” on 
page 44.
If you are already in the Trial Balance Import tool for the selected return, 
go to the Trial Balance Import window in Drake and start at Step 3 of 
the following procedure.

NOTE
If the program does not calculate the trial-balance information as 
expected, you can return to the trial balance worksheet, make adjust-
ments, and import the worksheet again.
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Additional 
Import 

Options

The program can import the following additional information when importing the trial 
balance data (select the items to import or click Select All):

Special Conditions
Some items cannot be entered into the trial balance worksheet and must be typed 
directly into data entry. Other items should be entered into the worksheet for balance 
purposes but are not imported to data entry; these must be entered separately and the 
calculated results compared to the trial balance worksheet.

Details for 
Preparers

Most items go directly to the location indicated in the program and on the return. For 
example, the amounts shown in Figure 31 go to Schedule L, line 1, column d in the 
program and are shown on page 4, Schedule L, line 1, column d of the 1120S return.

Figure 31: Indication of where an amount will go in Drake and on the return

Not all figures are imported directly, however, and some amounts are optional. An Use 
the “Other Information” column to indicate special conditions and additional informa-
tion regarding certain rows. Table 4 describes the most common notes in this column.

Buildings & other depreciable assets Accumulated depreciation

Land Goodwill & other intangible assets

Accumulated amortization 8825/Rent information

Table 4: “Other Information” Column Notes

Note Description

not included in totals The amount is required for importing purposes only but is 
not included in the totals shown on the trial balance.

does not carry Information cannot be imported and must be entered on the 
appropriate screen in Drake. Screen is specified in column 
to the left of “Other Information.”

optional Amount is optional; not required for import, but could require 
direct entry in the software.

enter as negative number Some deficits must be entered as negative numbers.

import includes the calculated 
change in inventory

Used for “total purchases”; when calculating cost of goods 
sold (COGS) in the return, the program takes the change in 
inventory into account for the Schedule A calculation.

[Form or Schedule] may be 
required

Non-financial information (such as names of officers for a 
Schedule E) must be completed in Drake, in addition to the 
financial data entered in the worksheet.
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All “does not carry” notes are accompanied by further instructions in the column to 
the left of the “Other Information” column, as shown in Figure 32.

SCH2 Detail Typically, a balance sheet subsidiary schedule (SCH2 detail screen for Schedule L) is 
required for an item marked “do not carry” on the trial balance.

Figure 32: SCH2 screen required for “do not carry” items

To complete an SCH2 detail screen in data entry:

1. Open the SCH2 screen in the return.
2. Select the line number from the SCH2 drop list.
3. Enter the applicable item descriptions and beginning- and end-of-year totals.

To enter details for additional lines of the Schedule L, press PAGE DOWN and repeat 
steps 2 and 3. Data is saved automatically upon entry.

When the return is produced, the Schedule L of the return reflects both the amounts 
imported from the trial balance worksheet and the totals of the amounts entered on the 
SCH2 screen.

See “The SCH2 Screen” on page 22 for more details on using the SCH2 screen.

Depreciation S corporation returns can have up to four components of total depreciation:

• COGS 
• Real estate rental
• Rental other than real estate
• Any remaining depreciation

For trial balance purposes, enter depreciation amounts directly into the appropriate 
fields on the trial balance worksheet. Note that, for 1120S trial balances, rental 
expense detail worksheets are required for 8825 and RENT depreciation.

NOTE
Enter 8825 and RENT depreciation amounts in the detail work-
sheets for importing purposes, but be aware that the 8825 and 
RENT screens in the program will have to be edited if 4562 detail 
screens (see Figure 33) are used.
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When the trial balance is imported, the COGS depreciation expense amount flows 
directly to the appropriate line of Schedule A on the return, and the rental depreciation 
expense amounts flow directly to the appropriate lines of the 8825 and RENT screens, 
as applicable. Because the remaining depreciation can comprise any number of assets, 
the amount entered on the trial balance does not flow to the return. To ensure that each 
component of the total remaining depreciation is calculated into the return, each asset 
must be entered on the applicable depreciation screens in data entry (Figure 33).

Figure 33: Enter depreciable asset data on a 4562 detail screen, or enter the total depreciation 
on the override screens. (Figure is from 1120S data entry menu.)

Rental 
Expenses

The following information applies only to S corporations with multiple rental proper-
ties.

The S corporation trial balances include lines for rental income and expenses. Both 
rental expense items require a trial balance detail worksheet.

Figure 34: Rental expense rows on an S corp trial balance worksheet

When imported, the rental expense data entered on the trial balance worksheet appears 
on either the 8825 screen (if real estate rental) or the RENT screen (if rental other than 
real estate).

NOTE

Entering the remainder of the depreciation on the trial balance work-
sheet helps ensure that the balance sheet balances and provides a way 
to check that the amount on line 1 of Schedule M-1 is correct. Compare 
the calculated line 1 at the bottom of the trial balance to the equivalent 
line on Schedule M-1 of the calculated return. If the depreciation 
amounts match but the line 1 amounts differ, an M-1 adjustment could 
be required.
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Because the trial balance worksheet has only one detail screen per rental type, the 
importing function does not accommodate entities with multiple rental properties or 
expenses; however, the following procedure allows the trial balance to remain in bal-
ance if there are multiple rental properties or expenses.

To accommodate entities with multiple rental properties or expenses:

1. Calculate the totals for both types of rental expenses.
2. Enter the income totals on the trial balance sheet and the expense totals on the 

applicable detail sheets (Figure 34).
3. Ensure that the balance sheet is in balance.
4. Import the trial balance worksheet into the return. The applicable screens in data 

entry now contain the figures entered on the trial balance worksheet.
5. Enter the amounts on additional screens that require details. (For more informa-

tion on data that cannot be imported, see “Special Conditions” on page 44.)
6. Compare the M-1, line 1 amount on the trial balance to the M-1, line 1 amount on 

the calculated return to ensure that they match.

7. Complete all 8825 or RENT screens in data entry, as applicable, for the individual 
rental properties or items.

8. Delete the 8825 and RENT screens that were imported from the trial balance (the 
screens reflecting the total rental expenses).

Form 3115, Application for Change in Accounting Method
Form 3115, Application for Change in Accounting Method, is an application to the 
IRS to change either an entity’s overall accounting method or the accounting treat-
ment of any item. Drake customers can now fill out Form 3115 and related schedules 
and attachments for corporate returns. This section provides instructions for complet-
ing this form and related schedules and attachments in Drake.

NOTE
If the amounts do not match, review the imported amounts to ensure 
that all data was imported. If the data appeared to import correctly, an 
M-1 adjustment could be necessary.

NOTE
To delete a screen in data entry, open the screen and press CTRL+D. If 
a multiple forms list appears, ensure that the screen to delete is 
selected, then click Delete.

NOTES

In some cases, Form 3115 must still be paper-filed. See “Parts I and III,” 
starting on page 49, for details.
Applicants filing Form 3115 must refer to the Internal Revenue Bulletins 
(available at www.irs.gov) to determine if the IRS has published an 
accounting method revenue procedure, revenue ruling, notice, regula-
tion, or other guidance relating to the specific method to be changed. 
See Pub. 538, Accounting Periods and Methods.
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Accessing Screens for Changing Accounting Method
Several screens may be required to complete Form 3115. These screens are accessible 
from the Change in Accounting Method box, located under the first Other Forms 
tab of the Data Entry Menu (Figure 35).

Figure 35: Screens for Form 3115, Application for Change in Accounting Method

The screens accessible from the Change in Accounting Method section include:

• Screen 3115 (Change in Accounting Method) — Used to access fields for Form 
3115, including Schedules A through D

• Screen 311E (Schedule E) — Used to request a change in depreciation or amorti-
zation methods

• Screen ATT (Explanations and Attachments) — Used to create and view cer-
tain attachments to be generated by the software

• Screen ATT2 (Pt II Ln 12 & Pt III Ln 23b Attachment) — Used to complete 
certain parts of Form 3115 that require specific attachments

Multi-form 
Codes

All 3115 and related screens contain a Multi-form code text box (shown in Figure 36) 
that allows you to link a screen or attachment to a particular Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new appli-
cation you create in Drake. The first should be 1, the second 2, and so on. When using 
other screens, such as the 311E or ATT screens, you can use those numbers to indicate 
which instance of Form 3115 the 311E or ATT screen should be associated with; see 
“Screen 311E Multi-form Codes” on page 54 for more information.

NOTE If only one Form 3115 is being submitted, you do not need to enter any-
thing in the Multi-form code box.
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Form 3115 Screens
When you open the 3115 screen from the Data Entry Menu, the program displays the 
first of five 3115 screens. These five screens are:

• Parts I, III (Form 3115, Parts I and III)
• Parts II, IV (Form 3115, Parts II and IV)
• A, B, C (Form 3115, Schedules A, B, and C)
• D - I, II (Form 3115, Schedule D, Parts I and II)
• D - III (Form 3115, Schedule D, Part III)

As shown in Figure 36, you can access these 3115 screens by clicking a link at the top 
of any other 3115 screen.

Figure 36: Tab links on 3115 screen

The next few sections of this document provide instructions for completing the vari-
ous screens for Form 3115 (including Schedules A through D).

Parts I and III Use the Parts I, III screen to complete the following sections of Form 3115:

• General Information
• Part I, Information For Automatic Change Request
• Part III, Information For Advance Consent Request

General 
Information

Complete all applicable fields in the General Information section. Note that the 
fields for business activity and tax-year change are override fields (Figure 37). Com-
plete these fields only if you want to override the equivalent information entered on 
screen 1 or screen K.

Figure 37: Override fields in the General Information sections of the Parts I, III screen

Part I Not all applicants are eligible to use the automatic change request procedures. After 
answering 1a, 1b, and 2 in Part I - Information for Automatic Change Request, 
click the blue Parts II, IV tab at the top of the screen.

NOTE Information should be entered in either the Part I section or the Part III 
section, but not both.
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In Part II – Information for All Requests, answer question 3 (see Figure 38). If the 
answer is Yes, you are stating that:

• The entity would be required to take the entire amount of the section 481(a) 
adjustment into account in computing taxable income for the year of change.

• Section 4.02(8) of Rev. Proc. 2002-9 applies to the applicant’s accounting method 
change request, and the applicant is therefore not eligible for a change under auto-
matic change request procedures. (See IRS Form 3115 instructions for details.)

Figure 38: Automatic Change Request information

Part III If this section of the Parts I, III screen is filled out, Form 3115 cannot be e-filed with 
the return. It must instead be paper-filed before submitting the return. A user fee (a 
check or money order payable to the IRS) must be included with the paper-filed form.

If the applicant qualifies for a reduced user fee, answer Yes on line 23b and go to 
screen ATT2 to complete the attachment information for Part III, line 23b (located in 
the bottom half of the screen). Include the necessary information or certification 
required by Rev. Proc. 2003-1 (or its successor).

Specific statements must also be attached to the return if the applicant answers Yes for 
line 18 (“Is change request allowed under automatic change?”) or No for line 22 (All 
members of consolidated group use proposed method?). Press F1 in a specific field for 
more information on attachment requirements. The method for attaching statements in 
Drake is covered in “Attachments,” starting on page 54.

Parts II and 
IV

Use the Parts II, IV screen to complete the following sections of Form 3115:

• Part II, Information For All Requests
• Part IV, Section 481(a) Adjustment

In addition to the Multi-form code text box, this screen consists of the Part II and 
Part IV sections. Applicants must complete both sections of this screen. For more on 
each line (including instructions for required attachments), press F1 in a specific field.

Part II, Line 12 Note that there is no field on the Parts II, IV screen for Part II, line 12. Fields for line 
12, which should be completed if the applicant is changing only the accounting 
method for a particular item or items, are located in the top half of ATT2 screen. Use 
these fields to enter information on:

NOTES
See Appendix A of Rev. Proc. 2006-1 for more information. For more on 
applicants who must apply for advance consent, see the IRS Form 
3115 instructions.
Taxpayers filing under an automatic change request procedure do not 
pay a user fee.
50 Tax Year 2010



Drake Software User’s Manual Supplement: S CorporationsForm 3115, Application for Change in Accounting Meth-
• The items being changed
• The applicant’s present and proposed methods for the items being changed
• The applicant’s present overall method of accounting (cash, accrual, or hybrid)

Note that the bottom half of the ATT2 screen is for completing Part III, line 23b. Only 
the top half (for Part II, line 12) needs to be completed for Part II, line 12.

Schedules A, 
B, and C

Click the A, B, C link from screen 3115 screen to complete the following sections of 
Form 3115:

• Schedule A, Change in Overall Method of Accounting (screen covers Part 1, 
Change in Overall Method)

• Schedule B, Change in Reporting Advance Payments
• Schedule C, Changes Within the LIFO Inventory Method (screen covers both Part 

I, General LIFO Information, and Part II, Change in Pooling Inventories)

Schedule A This section is required for all applicants filing to change their overall method of 
accounting. It requires the entry of amounts as they were at the close of the tax year 
preceding the year of the requested change.

The IRS requires a worksheet for lines 1a, 1c, 1d, 1e, and 1f of Schedule A. When you 
enter an amount on any of these lines in Drake, a Ctrl+W worksheet is automatically 
opened, allowing you to begin entering the descriptions and amounts of multiple items 
for the worksheet. When you close a Ctrl+W worksheet, the program returns to the 
original screen and displays the total in the field. The field is shaded (default is red) to 
indicate that a Ctrl+W worksheet has been used. 

Schedule B This section has just two lines, both referring to the request for deferral for advance 
payments:

• Line 1 — Request change to the deferral method for advance payments (from sec-
tion 5.02 of Rev. Proc. 2004-34)

• Line 2 — Request change to the deferral method for advance payments (from sec-
tion 1.451-5(b)(1)(ii))

See IRS Form 3115 instructions for more information on making these requests.

Schedule C This section has two parts:

NOTE
Schedule A, Part II (Change to the Cash Method for Advance Consent 
Request) requires attachments and is not addressed on the A, B, C 
screen.

NOTE
Leave blank any lines that aren’t required for the entity’s application. In 
addition, exclude amounts not attributable to the change in method of 
accounting—for example, amounts that correct a math or posting error, 
or that correct errors in calculating tax liability.

NOTE If nothing is entered in a Schedule A field, the program automatically 
displays the word “NONE” in the field on the generated form.
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• Part I (General LIFO Information) — This section is made up of attachment links 
(see Figure 42 on page 55). If any of the conditions on lines 1–6 match the entity’s 
situation, click the corresponding attachment link to access the ATT screen, 
where you can complete the required statement. (Select the corresponding line 
code from the Schedule drop list on the ATT screen.)

• Part II (Change in Pooling Inventories) — Enter the descriptions of the contents 
and the base years of the present and proposed pools. If any of the conditions on 
lines 2–4 match the entity’s situation, click the corresponding attachment link to 
access the ATT screen, where you can complete the required statement.

Schedule D, 
Parts I and II

Use the D - I, II screen to complete the following parts of Form 3115, Schedule D, 
Change in the Treatment of Long-Term Contracts Under Section 460, Inventories, or 
Other Section 263A Assets:

• Part I, Change in Reporting Income From Long-Term Contracts
• Part II, Change in Valuing Inventories Including Cost Allocation Changes

Schedule D, 
Part I

A long-term contract refers to any contract for the manufacture, building, installation, 
or construction of property that is not completed in the tax year in which it is entered 
into. Answer the questions in Part I that apply to the entity’s situation.

Schedule D, 
Part II

This section concerns changes in the identification and valuation methods of invento-
ries. Note that some lines require attachments. To access the ATT screen and complete 
a required statement, click the desired attachment link.

The items on this part of the screen match the items on the actual Form 3115, Sched-
ule D. For information on completing individual lines, see the Form 3115 instructions.

Schedule D, 
Part III

Use the D - III screen to complete Part III (Method of Cost Allocation) of Form 3115, 
Schedule D. Part III is required for any entity submitting either Part I or Part II. Screen 
D - III consists of the following sections:

• Section A, Allocation and Capitalization Methods
• Section B, Direct and Indirect Costs Required to be Allocated
• Section C, Other Costs Not Required to be Allocated

Section A Click the D3-1 Attachment link (see Figure 40) to attach a description of the present 
and proposed methods used to capitalize direct and indirect costs.

NOTE
If an entity is currently using a LIFO inventory method or submethod 
and is changing to another LIFO inventory method or submethod, Part 
II of Schedule D is not applicable. Use Schedule C, Changes Within the 
LIFO Inventory Method, instead.

NOTE

If the entity is unable to furnish a copy of Form(s) 970 (line 5a), the 
attachment must include the following statement:
“I certify that to the best of my knowledge and belief (name of applicant) 
properly elected the LIFO inventory method by filing Form 970 with its 
return for the tax year(s) ended (insert date(s)) and otherwise complied 
with the provisions of section 472(d) and Regulations section 1.472-3.”
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Sections 
B and C

These sections consist of a series of drop lists under a Present column and a Proposed 
column. “Present” refers to the current accounting method, while “proposed” refers to 
the requested change in accounting methods. You should address only the items neces-
sary; do not make a selection for any item for which an answer is not required for the 
entity’s situation.

For each item in sections B and C, you can:

• Select X — If you select X, the corresponding box on Form 3115 will be marked 
with an X. (See Figure 39.)

• Select B — If you select B, the corresponding box on Form 3115 will be left blank 
and an attachment will be required explaining why the line was left blank.

• Select nothing — If you select neither of the above options, “N/A” will appear in 
the corresponding box on Form 3115. No attachment is necessary for a box 
marked “N/A.”

Figure 39: X was selected for column 1, line 1; B was selected for column 1, line 2;
nothing has yet been selected for any other line. (See also Figure 40.)

To attach a statement for section B or C, click the D3-2 Attachment link at the top of 
Section B. (See Figure 40.) A single statement may contain all necessary explanations 
for sections B and C.

Figure 40: If any box is marked “B,” click the D3-2 Attachment link to open
the ATT screen and complete the fields for an attached statement.

Schedule E
Use screen 311E, accessible from the Change in Accounting Method section of the 
Other Forms tab, to complete Schedule E, Change in Depreciation or Amortization.

NOTE
If changing this method under the automatic change request proce-
dures, see the “List of Automatic Accounting Method Changes” in the 
IRS Form 3115 instructions.
Tax Year 2010 53



Form 3115, Application for Change in Accounting Method Drake Software User’s Manual Supplement: S Corpora-
Screen 311E 
Multi-form 

Codes

Unlike the other 3115 screens, screen 311E contains two multi-form code text boxes:

• Multi-form code for 3115 — This box is applicable if the return contains more 
than one Form 3115. Enter the code for the instance of the 3115 screen with which 
this 311E screen should be associated.

• Multi-form code for Sch E — This box is applicable if the return contains more 
than one Schedule E. (A separate 311E screen should be used for each property.) 
Assign each property a separate code in its Multi-form code for Sch E. This code 
enables you to associate any attachments with the correct Schedule E property. 
(See “Attachments,” starting on page 54.)

If the return contains more than one Form 3115 and multiple instances of Schedule E, 
both multi-code fields should contain numbers. Figure 41 shows that the third instance 
of a Schedule E is to be associated with the second Form 3115 in the return.

Figure 41: Example of third instance of a Schedule E to be associated
with the second instance of a Form 3115.

Completing 
Schedule E

The 311E screen consists of four sections:

• Schedule E - Line 4a — Enter information on the type of property, the year it was 
placed in service, and the property’s use.

• Schedule E - Change in Depreciation or Amortization — This section covers 
all Schedule E items other than lines 4a and 7. Note that lines 5 and 6 are links to 
required attachments.

• Schedule E - Line 7 - Present Method and Schedule E - Line 7 - Proposed 
Method — For the line 7 sections, enter information on the Present Method and 
Proposed Method in the supplied text boxes and choose the applicable conven-
tion from the Applicable Convention drop list. Options are as follows:

Attachments
Attached statements are required for many Form 3115 items. Depending on the nature 
of the attachment, you will attach statements to the form in one of two primary ways:

• From Data Entry — The ATT screen is the most common screen for attaching 
statements to Form 3115. The ATT2 screen is used for Part II, line 12, and Part 

• HY — Half-Year • MM — Mid-month

• MQ — Mid-quarter • S/L — Straight line
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III, line 23b. (See the “Parts I and III” and “Parts II and IV” sections of this docu-
ment for more information on completing the ATT2 screen for these items.)

• From View Mode — Used for PDF attachments.

 ATT Screen 
Attachments

There are two ways to access the ATT screen in Drake:

• From the Data Entry Menu — In the Change in Accounting Method section of 
the Other Forms tab, click ATT. (See Figure 35 on page 48.)

• From the line that requires an attachment — As shown in Figure 42, some 
lines have attachment links. Click an attachment link to open the ATT screen.

Figure 42: Attachment links from Schedule C (screen A, B, C)

Complete the following ATT fields, as applicable, for all ATT screen attachments:

• Multi-form codes — Use these boxes to associate the attachment with an 
instance of Form 3115 (if the return contains more than one), a particular Sched-
ule E property (if the return contains more than one Schedule E), or both. (See 
“Multi-form Codes” on page 48 for more information on multi-form codes.)

• Schedule — Select the line of the form or schedule with which the attachment is 
to be associated. If an item begins with a number, it refers to the part of Form 3115 
(for example, 2-4e refers to Part II, line 4e). If it begins with a letter, it refers to a 
particular Form 3115 schedule (for example, C2-b refers to Schedule C, line 2b; 
C2-5 refers to Schedule C, Part 2, line 5).

• Explanation — Enter the statement explanation. If the explanation requires more 
than 900 characters, press PAGE DOWN for a second screen.

Additional 
ATT Fields

The ATT screen has a separate section, to be used only for Part II, line 10. The IRS 
requires that the attached statement, in addition to providing an explanation, include 
the taxpayer’s name and ID number. Enter the name and ID number, and indicate if 
the ID number is an EIN, in the applicable fields at the bottom of the ATT screen 
(Figure 43).

NOTE
Not all lines that require statements include a link to the ATT screen. 
Always check the field-level help (click F1 in a field) to determine if a 
statement is required. The program produces an EF Message if any 
required statements are missing.

NOTE
If the explanation requires more than seven screens, only the first 6,500 
characters of the explanation are transmitted with an e-filed Form 3115. 
There is no character limit for paper-filed returns.
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Figure 43: Special section for entering taxpayer name and ID number
for Part II, line 10; located at bottom of the ATT screen.

PDF 
Attachments

Some Form 3115 items require the attachment of documents that cannot be created in 
Drake Software; for example, line 4d of Part II requires written consent from a direc-
tor. You can, however, attach such a document to the form as a PDF.

See the PDF screen for directions on generating and attaching PDFs. Click the Screen 
Help button for directions on converting other types of documents into PDF.

When the return is generated, an “EF Attachments” worksheet is produced. (See 
Figure 44.) This worksheet shows, in table format, the Reference (section of Form 
3115), the Description, and the IRS-required Filename of each required PDF docu-
ment. This worksheet is displayed as EF_PDF~ in View mode.

Figure 44: Example of an EF Attachments worksheet

Notices of 
Missing 

Attachments

In addition to Form 3115 and related schedules and statements, the program produces 
EF message pages (as applicable) when the return is calculated. All forms, schedules, 
EF message pages, and worksheets are accessible from View mode.

EF messages for Form 3115 provide information about required attachments (includ-
ing PDF attachments) that are missing from the return. Some messages list all state-
ments required for a particular section but do not indicate which statements, 
specifically, are missing. To best understand which attachments are still required, 
compare the ATT screen and the EF_PDF~ worksheet to the list on the EF message 
page.

NOTES

Do not enter data on the PDF screen itself. If using the directions pro-
vided on that screen, skip Step 2, which instructs you to fill out the col-
umns at the bottom of the PDF screen.
A PDF document may be attached using any filename. When you 
attach the document, the program automatically assigns it the filename 
required by the IRS.

NOTE
All EF messages must be eliminated before the return is eligible for 
e-file. EF messages for Form 3115 attachments are eliminated 
when all required statements have been attached to the return. 
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Appendix: Trial Balance Import

The trial balance import allows data to be imported into a corporate tax return from a 
trial balance worksheet.

Drake’s specially designed trial balance template and importing function has the fol-
lowing benefits:

• Eliminates the need to duplicate entries
• Eliminates data entry errors by automatically importing data to the correct fields
• Allows preparers to merge basic accounting functions with tax preparation

See next page for a flow chart describing the use of the trial balance import.
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Index

Numerics
52-53-week year returns 33

A
accounting method

changing 47–56
entering 5

accumulated adjustments account (Schedule M-2) 27
address

change of 5
e-mail 15
entering on Form 1120S 4
foreign 18
on K-1 letter heading 20
out-of-state 16

adjusted basis worksheet 21, 32
adjustments

depreciation 25
section 481 7
to income and expenses 30

advertising expenses 9
amended

1120S returns 5, 14
K-1 letters 21

amortization 10, 22
analysis of accounts (Schedule M-2) 26–28
asterisks (on K-1 codes) 18
attachments

binary (PDF) 34–37
Form 8825 statements 30

auto-balance 24

B
bad debts 7, 8
basis 21–22

see also adjusted basis worksheet
binary (PDF) attachments 3
book-to-tax differences (Schedule M-1) 24
business activity codes 4

C
calendar-year returns 4
change of name or address 5
charitable contributions 16
Client Communications Editor (for letters) 21

codes
business activity 4
error/reject 34
K-1 17, 32
miscellaneous (screen 1) 16
multi-form 29, 48, 54, 55

compensation of shareholders 7
contact information (for state returns) 15
cost of goods sold, see  Schedule A (Cost of Goods Sold)
cover letters (K-1) 20
coversheets 32
credits 30
Ctrl+W (detail) worksheets 5, 6, 39

D
data entry

for state information 15
importing trial balance into 38–47

dates
of incorporation 5
payment (changing) 12
stock transaction 17
tax year 4

decrease to basis 22
deductions 7–10
depletion 9
depreciation 6

and auto-balance errors 24
expense 9
for cost of goods sold (Schedule A) 6
installment sales and like-kind exchanges 1
of rentals 29
on short-year returns 4
printing Form 4562 31
trial balance (business returns only) 45

detail (Ctrl+W) worksheets 5, 6, 39
direct debit of balance due 12–13
direct deposit of refunds 11
distributions 26
domestic production activities deduction 19
due dates 12

E
e-filing

Form 1120S 32
PDF attachments 34–37
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statements 23
electronic

funds withdrawal 12–13
signatures (PIN) 13

employer identification number (EIN) 5
envelope coversheets 32
error codes 34
estimates

2008 tax 10
2009 payments 11
underpayment of 11

expenses 7–10
exporting K-1 data 18
extensions 13

F
filing instructions 32
final return 5
fiscal year returns 4
foreign

addresses for shareholders 18
transactions 12, 16

Form 1120-C (U.S. Income Tax Return for Cooperative 
Associations) 1

Form 2553 (Election by a Small Business Corporation) 3, 5
Form 3115 (Application for Change in Accounting Meth-

od) 47–56
Form 4136 (Credit for Federal Tax Paid on Fuels) 11
Form 4562 (Depreciation and Amortization) 29, 31
Form 4797 (Sales of Business Property) 6
Form 5884 (Work Opportunity Credit) 31
Form 6252 (Installment Sale Income) 1
Form 6478 (Alcohol and Cellulosic Biofuel Fuels Credit)

6, 31
Form 6765 (Credit for Increasing Research Activities) 31
Form 7004 (Application for Automatic Extension of Time 

to File) 13
Form 8027 (Employer’s Annual Information Return of Tip 

Income & Allocated Tips) 1
Form 8050 (Direct Deposit of Corporate Tax Refund) 11
Form 8820 (Orphan Drug Credit) 31
Form 8825 (Rental Real Estate Income and Expenses of a 

Partnership or an S Corporation) 28–30
Form 8844 (Empowerment Zone and Renewal Community 

Credit) 31
Form 8845 (Indian Employment Credit) 31
Form 8846 (Credit for Employer Social Security and Medi-

care Taxes Paid on Certain Employee Tips) 8, 31
Form 8864 (Biodiesel and Renewable Diesel Fuels Credit)

6, 31
Form 8873 (Extraterritorial Income Exclusion) 10
Form 8881 (Credit for Small Employer Pension Plan Star-

tup Costs) 31

Form 8903 (Domestic Production Activities Deduction) 19
Form 8912 (Credit to Holders of Tax Bonds) 31
Form 8912 (Credit to Holders of Tax Credit Bonds) 31
Form 8916-A (Supplemental Attachment to Schedule M-3)

25
Form 8941 (Credit for Small Employer Health Insurance 

Premiums) 31
Form 8941 (Credit for Small Employer Health-Insurance 

Premiums) 10
Form T (Forest Activities Schedules) 9

G
gains and losses 6
gross receipts 5

H
header information 3

I
import, trial balance 38–47
inactive returns 31, 34
income 5–7
increase to basis 22
installment sales 1
instructions for filing 32
insurance proceeds, income from 7
interest

expense 9
income 7

inventory 5

K
K-1, Schedule for 1120S 17–22

L
labor 7
letters (K-1) 20
like-kind exchanges 1

M
maintenance costs 8

N
name change 5
net operating losses (NOL) 28
next-year depreciation listing 31
number of shareholders 5
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O
ordinary gains and losses 6
other

adjustments account 28
costs (Schedule A) 6
income (loss) 6

P
passive income 10
PDF (binary) attachments 3, 34–37
PIN (electronic) signatures 13
printing

cover letter for K-1 20
K-1 items 18
line 22a worksheet 10
statements for Schedule L 23
suppressing/forcing documents 31

R
real estate 45
receipts 5
references to forms and worksheets 31
refunds

direct deposit of 11
state tax 7

reject codes 34
rent paid on business property 8
rental activities 28–30
repair costs 8
retained earnings reconciliation (worksheet) 31
returns

52-53-week year 33
amended 14
bankruptcy 32
extensions for 11, 13
fiscal and calendar year 4
inactive 34
short-year 4
signing 13
tax-exempt organizations (990) 34–37
updating prior-year 3

revocation of S election 5

S
S corporation

changing to 3
electing as 3
termination of 5

scanning (PDFs for e-filing) 34
SCH2 screen (for Schedule L) 22
Schedule A (Cost of Goods Sold) 5

Schedule B (Other Information) 15
Schedule D (Capital Gains and Losses and Built-In Gains)

bad debts 8
Parts I, III, and III 10

Schedule E (Officer Information) 16
Schedule F (Profit or Loss from Farming) 5
Schedule K (Shareholders’ Pro Rata Share Items) 16–17
Schedule K-1 (Shareholder Information) 17–22
Schedule L (Balance Sheet per Books) 22–24, 31
Schedule M-1 24, 31
Schedule M-2 26–28
Schedule M-3 25
schedules on Form 3115 51–54
section

1245 property 1
1250 property 1
179 income limitations 7
481 adjustments 7
481(a) adjustments 50

shareholders
adjusted basis worksheet 21–22
compensation of 7
foreign addresses for 18
multiple 18
number of 5
Schedule K-1 17
updating data annually 22

short-year returns 4
signatures, electronic 13
state

address 16
-specific information 15
tax refunds 7, 12

stock transaction dates 17

T
tax

and payments 10–11
on fuels, credit for 7
returns, see returns
years (fiscal vs calendar) 4

taxes and licenses 8
termination of S election 5
trial balance import

and depreciation 6
and Schedule L 22, 23
instructions for using 38–47

U
underpayment of estimated tax 11
undistributed taxable income previously taxed 28
updating
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an 1120S return 3
shareholder data annually 22

V
Vista (Windows operating system) 38
vouchers 10

W
wages 7
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